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Document Conventions

The following table lists the text conventions that are used throughout this guide.

TABLE 1 Text Conventions

Convention Description Example

monospace Identifies command syntax device (config) # interface ethernet 1/1/6
examples

bold User interface (Ul) components On the Start menu, click All Programs.

such as screen or page names,
keyboard keys, software buttons,
and field names

italics Publication titles Refer to the Ruckus Small Cell Release Notes for more information.

Notes, Cautions, and Warnings

Notes, cautions, and warning statements may be used in this document. They are listed in the order of increasing severity of
potential hazards.

NOTE
A NOTE provides a tip, guidance, or advice, emphasizes important information, or provides a reference to related
information.

ATTENTION
An ATTENTION statement indicates some information that you must read before continuing with the current action or
task.

CAUTION
A CAUTION statement alerts you to situations that can be potentially hazardous to you or cause damage to

hardware, firmware, software, or data.

DANGER
A DANGER statement indicates conditions or situations that can be potentially lethal or extremely hazardous to you.
Safety labels are also attached directly to products to warn of these conditions or situations.
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Preface
Command Syntax Conventions

Command Syntax Conventions

Bold and italic text identify command syntax components. Delimiters and operators define groupings of parameters and their
logical relationships.

Convention Description

bold text Identifies command names, keywords, and command options.
italic text Identifies a variable.

[1 Syntax components displayed within square brackets are optional.

Default responses to system prompts are enclosed in square brackets.

{x|y|z} A choice of required parameters is enclosed in curly brackets separated by vertical bars. You must select one of the
options.

x|y A vertical bar separates mutually exclusive elements.

<> Nonprinting characters, for example, passwords, are enclosed in angle brackets.

Repeat the previous element, for example, member[member...].

\ Indicates a “soft” line break in command examples. If a backslash separates two lines of a command input, enter the
entire command at the prompt without the backslash.

Document Feedback

Ruckus is interested in improving its documentation and welcomes your comments and suggestions.
You can email your comments to Ruckus at ruckus-docs@arris.com.
When contacting us, include the following information:
*  Document title and release number
*  Document part number (on the cover page)
*  Page number (if appropriate)
For example:
*  Ruckus SmartZone Upgrade Guide, Release 5.0
*  Part number: 800-71850-001 Rev A
* Page7?

Ruckus Product Documentation Resources

Visit the Ruckus website to locate related documentation for your product and additional Ruckus resources.

Release Notes and other user documentation are available at https://support.ruckuswireless.com/documents. You can locate the
documentation by product or perform a text search. Access to Release Notes requires an active support contract and a Ruckus
Support Portal user account. Other technical documentation content is available without logging in to the Ruckus Support Portal.

White papers, data sheets, and other product documentation are available at https://www.ruckuswireless.com.

Ruckus Virtual SmartZone Getting Started Guide
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Online Training Resources

To access a variety of online Ruckus training modules, including free introductory courses to wireless networking essentials, site
surveys, and Ruckus products, visit the Ruckus Training Portal at https://training.ruckuswireless.com.

Contacting Ruckus Customer Services and
Support

The Customer Services and Support (CSS) organization is available to provide assistance to customers with active warranties on
their Ruckus products, and customers and partners with active support contracts.

For product support information and details on contacting the Support Team, go directly to the Ruckus Support Portal using
https://support.ruckuswireless.com, or go to https://www.ruckuswireless.com and select Support.

What Support Do | Need?

Technical issues are usually described in terms of priority (or severity). To determine if you need to call and open a case or access
the self-service resources, use the following criteria:
e Priority 1 (P1)—Critical. Network or service is down and business is impacted. No known workaround. Go to the Open a
Case section.
*  Priority 2 (P2)—High. Network or service is impacted, but not down. Business impact may be high. Workaround may be
available. Go to the Open a Case section.
*  Priority 3 (P3)—Medium. Network or service is moderately impacted, but most business remains functional. Go to the
Self-Service Resources section.

*  Priority 4 (P4)—Low. Requests for information, product documentation, or product enhancements. Go to the Self-
Service Resources section.

Open a Case
When your entire network is down (P1), or severely impacted (P2), call the appropriate telephone number listed below to get
help:

* Continental United States: 1-855-782-5871

* Canada: 1-855-782-5871

* Europe, Middle East, Africa, Central and South America, and Asia Pacific, toll-free numbers are available at https://
support.ruckuswireless.com/contact-us and Live Chat is also available.

*  Worldwide toll number for our support organization. Phone charges will apply: +1-650-265-0903

We suggest that you keep a physical note of the appropriate support number in case you have an entire network outage.

Self-Service Resources

The Ruckus Support Portal at https://support.ruckuswireless.com offers a number of tools to help you to research and resolve
problems with your Ruckus products, including:

*  Technical Documentation—https://support.ruckuswireless.com/documents

Ruckus Virtual SmartZone Getting Started Guide
Part Number: 800-71961-001 Rev A 9
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Community Forums—https://forums.ruckuswireless.com/ruckuswireless/categories

Knowledge Base Articles—https://support.ruckuswireless.com/answers

Software Downloads and Release Notes—https://support.ruckuswireless.com/#products_grid

Security Bulletins—https://support.ruckuswireless.com/security

Using these resources will help you to resolve some issues, and will provide TAC with additional data from your troubleshooting
analysis if you still require assistance through a support case or RMA. If you still require help, open and manage your case at
https://support.ruckuswireless.com/case_management.

Ruckus Virtual SmartZone Getting Started Guide
Part Number: 800-71961-001 Rev A


https://forums.ruckuswireless.com/ruckuswireless/categories
https://support.ruckuswireless.com/answers
https://support.ruckuswireless.com/#products_grid
https://support.ruckuswireless.com/security
https://support.ruckuswireless.com/case_management

About This Guide

L N o Yo 10 | i I a3 U 1 LTSRS 11

About This Guide

This Virtual SmartZone (vSZ) Getting Started Guide provides information on how to set up the vSZ virtual appliance on the
network. You can install the vSZ on any of the supported hypervisors.

Topics covered in this guide include preparing your chosen hypervisor, installing the vSZ image on to the hypervisor, and
completing the vSZ Setup Wizard.

This guide is intended for use by those responsible for installing and setting up network equipment. Consequently, it assumes a
basic working knowledge of local area networking, wireless networking, and wireless devices.

NOTE
If release notes are shipped with your product and the information there differs from the information in this guide,
follow the instructions in the release notes.

Most user guides and release notes are available in Adobe Acrobat Reader Portable Document Format (PDF) or HTML on the
Ruckus Networks support website at https://support.ruckuswireless.com/documents.

Notice Conventions

The following table lists the notice conventions that are used throughout this guide.

TABLE 2 Notice Conventions

Notice Type Description
NOTE Information that describes important features or instructions
CAUTION! Information that alerts you to potential loss of data or potential

damage to an application, system, or device

WARNING! Information that alerts you to potential personal injury

Ruckus Virtual SmartZone Getting Started Guide
Part Number: 800-71961-001 Rev A
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Obtaining the vSZ Distribution

You have to download the .OVA file and documentation for the controller from the vSZ download page on the Ruckus Networks
support website. The vSZ distribution package, which is based on the Open Virtualization Format (OVF) framework, consists of a
virtual appliance.
Open Virtualization Format contains the following files:

*  Description file (.ovf)

*  Manifest file (.mf)

* Virtual machine state file (vmdk)

Preparing the vSZ Interface Settings to Use

vSZ comes with the option to operate with either one (1) network interface or three (3) network interfaces. Once the network
interface configuration has been made and setup executed, the number of network interfaces can no longer be modified.

CAUTION

A If you choose to operate the vSZ with three network interfaces, you must configure the three vSZ interfaces to
be on three different subnets when you run the Setup Wizard. Failure to do so may result in loss of access to the
web interface or failure of system functions and services.

* IP address

* Netmask

* Gateway

*  Primary DNS server

*  Secondary DNS server

TABLE 3 vSZ interfaces

Interface Description

AP Used for AP configuration and client traffic
Cluster Used for cluster traffic

Management (Web) Used for management traffic. The IP address

that you assign to this interface will be the IP
address at which you can access the vSZ web
interface.

Ruckus Virtual SmartZone Getting Started Guide
Part Number: 800-71961-001 Rev A 13
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Virtual SmartZone Required Resources

Before upgrading vSZ to this release, verify that the virtual machine on which vSZ is installed has sufficient resources to handle
the number of APs and wireless clients that you plan to manage. See the tables below for the required virtual machine system
resources.

The values for vCPU, RAM, and Disk Size are linked together and cannot be changed individually. When changing one of these
parameters, all three values need to match exactly with an existing Resource Level. Taking vSZ-H Resource Level 5 as an
example: when adjusting the number of vCPU from 4 to 6, the amount of RAM needs to be adjusted to 22GB and the Disk Size
needs to be adjusted to 300GB, thereby matching all of the values of Resource Level 6.

WARNING
A These vSZ required resources may change from release to release. Before upgrading vSZ, always check the required
resource tables for the release to which you are upgrading.

NOTE
When initially building up the network it is allowed to use a higher Resource Level than needed for the number of APs
first deployed, as long as all the three parameters (vCPU, RAM and Disk Size) match exactly with that higher Resource
Level.

ATTENTION
It is recommended that there should be only one concurrent CLI connection per cluster when configuring vSZ.

In the following tables the high scale resources are broken into two tables for easy readability. These tables are based on the AP
Count Range.

TABLE 4 vSZ High Scale required resources

AP Count Range Max Clients Nodes per AP Count per Node AP/Switch Switch Per
Cluster (without switch) Capacity Ratio Node(without AP)
From To Max Max
10,001 30,000 300,000 4 10,000 8:1 1,250
20,000 200,000 3 8:1 1,250
5,001 10,000 100,000 1-2 10,000 8:1 1,250
2,501 5,000 50,000 1-2 5,000 8:1 625
1,001 2,500 50,000 1-2 2,500 8:1 312
501 1,000 20,000 1-2 1,000 5:1 200
101 500 10,000 1-2 500 5:1 100
1 100 2,000 1-2 100 5:1 20

TABLE 5 vSZ High Scale required resources

AP Count Range vCPU RAM Disk Size Preserved Concurrent Resource
Events CLI Level
Connection
From To Logic Processor [1121 | GB[3] GB Max Max (per
3] node not per

cluster)

10,001 30,000 24 48 600 3M 4 8

20,000
5,001 10,000 24 48 600 3M 4 7

Ruckus Virtual SmartZone Getting Started Guide
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TABLE 5 vSZ High Scale required resources (continued)

AP Count Range vCPU
2,501 5,000 12
1,001 2,500 6
501 1,000 4
101 500 4
1 100 2

RAM

28
22
18
16
13

Disk Size

300
300
100
100
100

Preserved

Events

2M

1.5M
600 K
300K
60 K

Installation Preparation
Virtual SmartZone Required Resources

Concurrent
CLI
Connection

2

2
2
2
2

Resource
Level

w s v oo

In the following tables the essential scale resources are broken into two tables for easy readability. These tables are based on the

AP Count Range.

TABLE 6 vSZ Essentials required resources
AP Count Range

From To
1025 3,000 60,000
2,000 40,000
501 1,024 25,000
101 500 10,000
1 100 2,000

TABLE 7 vSZ Essentials required resources

AP Count Range vCPU
From To Logic Processor
[111213]
1025 3,000 8
2,000
501 1,024 8
101 500 4
1 100 2

NOTE

Logic Processor ' vCPU requirement is based on Intel Xeon CPU E5- 2630v2 @2.60 GHz.

Maximum Clients

RAM

GB B3I

18

18
16
13

Nodes per

Cluster

4

3

1-2

1-2

1-2
Disk Size
GB
250
250
100
100

AP Count per Node

Max
1,024

1,024
500
100

Preserved Events

Max

10K

10K
5K
1K

v o | n

AP/Switch Capacity
Ratio

Concurrent CLI
Connection

Max (per node not
per cluster)

2

Switch Per
Node(without
AP)

Max
200
200
200
100
20

Resource Level

1.5

Logic Processor 2 Azure with low CPU throughput unsupported. The vSZ with the lowest resource plan (2 core CPU, 13

GB memory) can NOT be supported due to the low CPU throughput on Azure.

Logic Processor 3 vSZ-H and vSZ-E have different report interval. For example, AP sends the status to vSZ-E every 90
seconds but to vSZ-H it is sent every 180 seconds, which means that vSZ-E need more CPU in scaling environment based

on the resource level.

Ruckus Virtual SmartZone Getting Started Guide
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Clustering Limitations

The following are the limitations for vSZ-H and vSZ-E.

Clustering Limitations for vSZ-H

vSZ-H supports up to 10,000 APs per node or 30,000 APs per cluster, assuming proper system resources are made

available. It supports clustering of up to 4 nodes when using Resource Level 6.

At 4 nodes, the maximum number of APs and clients that can be supported are 30,000 and 300,000 respectively.

Clustering Limitations for vSZ-E

VSZ-E supports up to 1,024 APs per node or 3000 APs per cluster, assuming proper system resources are available. It

supports clustering of up to 4 nodes when using Resource Level 2.

Above 2 nodes in a cluster at Resource Level 2, additional 2 CPU cores need to be added to each node to support the

added search capabilities and replication.

At 4 nodes, the maximum number of APs and clients that can be supported are 3,000 and 60,000 respectively.

NAT operation for vSZ cluster: Currently, each node requires its own public IP address for its NAT'ed interface. As such, a

1:1 NAT is recommended for setting up a cluster behind a NAT environment.

Ruckus Virtual SmartZone Getting Started Guide
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Preparing a Hypervisor

This section lists the hypervisors (and their release versions) on which you can install the vSZ.

TABLE 8 Hypervisors that the vSZ supports

Vendor Hypervisor Version

VMWare ESXi 6.7 and later

Windows Windows Server Hyper-V Windows Server Hyper-V (2012 R2)
KVM CentOS 7.4 (64bit)

Installing the vSZ on VMWare vSphere Hypervisor

You have to install the vSZ on a VMWare vSphere hypervisor.

Before You Begin

You have to complete the prerequisites before installing the vSZ on VMWare vSphere.
Verify that you have the prerequisites before installing the vSZ on VMWare vSphere.

*  Verify that vSphere client is installed.

*  You can deploy the vSZ only on hosts that are running ESXi version 6.7 and later.

* ThevSZ appliance requires at least 100GB of disk space and is limited to a maximum size of 600GB. The vSZ appliance
can be deployed with thinprovisioned virtual disks that can grow to the maximum size of 600GB.

Creating a vSZ Instance from the OVA File

You can create a vSZ instance using the vSphere Web Client.

Before continuing, ensure you have already downloaded the vSZ distribution package. See Obtaining the vSZ Distribution for
more information.
Follow these steps to create a vSZ instance from the OVA file.

1. Use the VMWare vSphere client to log on to the ESXi management interface.

Ruckus Virtual SmartZone Getting Started Guide
Part Number: 800-71961-001 Rev A 17
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2.

Click File> Deploy OVF Template. The Source screen of the Deploy OVF Template wizard appears.

FIGURE 1 Click Deploy OVF Template

@ Ruckus-Testl - vSphere Client

File | Edit View Inventory Administration Plug-ins Help

[E=1 EoR =<5

Mew 3

htory b [El Hosts and Clusters

Li)eploy OVF Template...

| E’,jv Search Inventory |Q|

Browse VA Marketplace...

Exit

[ [VSEg-2-5-pul |
3 vsm-5.1.2-1
B & vscg-cluster-1
{1 Barracuda Ly
3 John-vSCG
3 VMware Stu| _
& vscg-165-1
[ vscg-2.5.0.1
G vscg-2.5.0.1
[ vscg-2.5.0.1
@& vscg-cluster-2
3 sim-1
38 sim-2
B i PLM Lab
IE 172.16.112.217|

Export 3
Report 3

Print Maps 3

B e @

vsCg

What is a Virtual Machine?

& Amazon-EC2-VM

Vel ! 75
wern? &1 1106
] I 3

A virtual machine is a software computer that, like a
physical computer, runs an operating system and
applications. An operating system installed on a virtual
machine is called a guest operating system.

Because every virtual machine is an isolated computing
environment, you can use virtual machines as desktop or
workstation environments, as testing environments, or to
consolidate server applications.

In vCenter Server, virtual machines run on hosts or
clusters. The same host can run many virtual machines.

Basic Tasks

Power Off the virtual machine

I Suspend the virtual machine

summary ' ResourceAllocation ' Performance ' Tasks &Events ' Alarms ' Console ' Permissions

vSphere Client

.

Virtu

P

o

Cluster | S[5 &(

‘\' Datacer
vCenter Server

ol

F Tasks @ Marms |

lroot
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3. Click Browse to locate the .ova file that you downloaded earlier. Select the template.

FIGURE 2 Click Browse, and then locate and select .ova file

@ Deploy OVF Template EI@

Source
Select the source location.

Source
QVF Template Details
MName and Location
Host [ Cluster
Resource Pool
Disk Format Deploy from a file or URL

Ready to Complete

Browse...

Enter a URL to download and install the OVF package from the Internet, or
specify a location accessible from your computer, such as a local hard drive, a
network share, or a CD/DVD drive.

Help | < Back | MNext = I Cancel |
Y
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4. Click Next. The OVF Template Details screen appears.

FIGURE 3 The OVF Template Details screen

@ Deploy OVF Template

OVF Template Details
Verify OVF template details.

Source
OVF Template Details

End User License Agreement Product:
MName and Location .
. Version:
Host [ Cluster
Resource Pool Nexacio
Disk Format

Ready to Complete

Size on disk:

Description:

Download size:

Virtual Smart Cell Gateway
2.5.0.1. 166

Ruckus Wireless, Inc.

704.6 MB

1.8 GB (thin provisioned)
100.0 GB (thick provisioned)

Ruckus Virtual SmartCel ™ Gateway (wSCG), is a Network
Functions Virtualization (MFV) based WLAN Controller for service
providers and enterprises who desire a carrier-dass solution that
runs in the doud. It supports all of the WLAN Controller features
of the industry leading SCG-200, while also enabling the rollout of
highly scalable and resilient wireless LAN doud services.

=N~

Help |

< Back | Next > I Cancel |
Y

5. Review the OVA virtual appliance details, and then click Next. The End User License Agreement (EULA) screen appears.

20
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6. Click Accept to agree to the EULA terms, and then click Next. The Host/Cluster screen appears.

FIGURE 4 Accept the EULA for the vSZ OVA

[‘_F,.' Deploy OVF Template EI@

End User License Agreement
Accept the end user license agreements.

Source

OVF Template Details

End User License Agreems RUCKUS WIRELESS, INC. -
MName and Location Enterprise Software License

Host [ Cluster

m

Resource Pool PLEASE READ THIS SOFTWARE LICENSE CAREFULLY. RUCKUS WIRELESS, INC.
Dick Format ("RUCKLIS") 15 WILLING TO LICENSE THE SOFTWARE
= OMLY ON THE COMNDITION THAT THE LICENSEE ACCEPTS ALL OF THE FOLLOWING

Ready to Complete TERMS AND COMNDITIONS,

IF A USER ACCEFTS THIS LICENSE, OR. DOWNLOADS, LISES OR INSTALLS THE
SOFTWARE, AS AN EMPLOYEE OF, OR. AS AN AGENT

OR. CONTRACTOR. FOR THE BEMEFIT OF, A COMPANY, THAT COMPANY SHALL BE
DEEMED THE LICENSEE AND THE USER

REPRESENTS THAT IT HAS THE POWER AND AUTHORITY TO ACCEPT THIS AGREEMENT
©OM BEHALF OF THE COMPANY,

BY DOWNLOADING, INSTALLING AND/OR USING THE SOFTWARE, LICENSEE
ACKNOWLEDGES THAT IT HAS READ THIS LICENSE AND

AGREES TO BE BOUND BY ITS TERMS AND CONDITIONS, IF LICENSEE DOES NOT AGREE
TO THE TERMS AND CONDITIONS OF THIS

LICENSE, RUCKUS IS UNWILLING TO LICENSE THE SOFTWARE. IN THAT EVENT,
LICENSEE MAY NOT DOWNLOAD, LISE OR INSTALL

THE SOFTWARE AND SHALL BE GIVEN A FULL REFUND OF ANY LICENSE FEES ALREADY
PAID FOR THE SOFTWARE.

1) Definitions

"Device” means a single Ruckus access point or controller, as applicable, on Licensee’s
netwark,

“Documentation” means the published technical manuals, induding any updates thereto,
relating to the use of the Software made generally

available by Ruckus.

“Software” means a copy of a machine executable version of a Ruckus software product
that Ruckus makes available to Licensee for download

onto equipment owned or controlled by Licensee, and any error corrections, updates or
upgrades of such software product that Rudkus makes

available to Licensee.

“License Term"” means the period of time for which the licenses to the Software granted to =

Help | < Back MNext = Cancel |

A
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7.

Select the host or cluster on which you want to run the deployed template, and then click Next. The Resource Pool

screen appears.

FIGURE 5 Select the destination host or cluster

@ Deploy OVF Template

Host | Cluster

On which host or duster do you want to run the deployed template?

Source
OVF Template Details
End User License Agreement

MName and Location
E Host / Cluster
Spedfic Host
Resource Pool
Disk Format
Ready to Complete

El Jig PLM Lab
£ [Eng Test Bed ]
Gl PLM L

Help |

< Back | Next > I Cancel |
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8. Select the resource pool within which you want to deploy the template, and then click Next. The storage screen appears.

FIGURE 6 Select the resource pool for the OVA template

@ Deploy OVF Template EI@

Resource Pool
Select a resource pool.

Source

OVF Template Details
End User License Aqresment  Resource poals allow hierarchical management of computing resources within a host or duster. Virtual
machines and child pools share the resources of their parent pool.

Select the resource poal within which you wish to deploy this template.

Mame and Location

Host { Cluster
Resource Pool El [} |Eng Test Bed
Storage & Admin
Disk Format & vscg-cluster-1
Network Mapping E vscg-cluster-2
Ready to Complete Si sim-1

58 sim-2

Help | < Back | MNext = [ I Cancel |
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9. Select the destination storage (data store) for virtual machine files, and then click Next. The Disk Format screen

appears.

FIGURE 7 Select the data store for the virtual machine files

@ Deploy OVF Template
Storage
Where do you want to store the virtual machine files?
Source Select a destination storage for the virtual machine files:
OVF Template Details
End User License Agreement VM Storage Profile: I LI &
Name_amlw Name | Drive Type | Capacity | Provisioned | Free | Type | Thin Prot
;M“:l"'%l i datastorss 550 367.50 GB 392.55GB 14321 GB VMFS5  Support
esource Pool
Storage a datastorsd 55D 372.50 GB 343.34 GB 281.54 GB WMF55 Supporte
Disk Format B datastors7 SsD 365.00 GB 221.92GB  353.30 GB VMFSS Support:
Network Mapping @ datastorss SsD 37250 GB 157.68 GB  360.72GB VMFS5 Supporte
Ready to Complete B datastorenfs Unknown 49.22 GB 762.68 MB 4347 GB NFS Supporte
4 | 1l 3
" Disable Storage ORS fo al machine
Name Drive Type Capacity | Provisioned | Free | Type | Thin Provi
4 T | 3
Help | = Back | Next > & l Cancel |
4
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10. Select the disk format that is appropriate for your deployment scenario. Options include:
*  Thick Provision Lazy Zeroed
*  Thick Provision Eager Zeroed

e  Thin Provision

FIGURE 8 Select the disk format for your deployment scenario

[‘_F,.' Deploy OVF Template EI@

Disk Format
In which format do you want to store the virtual disks?

Source Datastore: |datasb3re3
OVF Template Details
End User License Agreement -
Available space (GB): 143.2
Mame and Location pace (GB)
Host { Cluster
Resource Pool
M_DIE = {* Thick Provision Lazy Zeroed
Disk Format
Network Mapping " Thick Provision Eager Zeroed
Ready to Complete (" Thin Provision

Help | < Back | Next > L\ls Cancel I

A

11. Click Next. The Network Mapping screen appears.
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12. Select the ESXi virtual network interface that you want to use for the control interface, and then click Next. The Ready
to Complete screen appears.

The installation screen only allows you to select the virtual network interface for the control interface. After you
complete the installation (and before you power on and set up the vSZ), you will need to adjust the cluster and
management interfaces as appropriate.

FIGURE 9 Select the virtual network interface that the template will use

@ Deploy OVF Template

Network Mapping

Source
OVF Template Details
End User License Agreement

MName and Location
Host { Cluster
Resource Pool
Storage

Disk Format
Network Mapping
Ready to Complete

What networks should the deployed template use?

Map the netwarks used in this OVF template to netwaorks in your inventaory

=N (ECR (==

Source Metworks
WM Network

Description:

DestinationMetworks

|1-'M MNetwark hd

Cluster Network

Management | xwork
VM Metwork
dvPLM_external
dvPLM_internal

dvPortGroup

The WM Netwark network

Help |

< Back | Next > I Cancel |

A
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13. Review the settings that you have configured on the previous screens. If you find a setting that you want to change, click
Back until you reach the screen where you can edit the setting. Update the setting, and then click Next until you reach

the Ready to Complete screen again.

FIGURE 10 Review the settings that you have configured

@ Deploy OVF Template

Ready to Complete
Are these the options you want to use?

Disk provisioning:
Network Map ping:

z?#lfrzmm ate Details When you dick Finish, the deployment task will be started.
End User License Agreement Deployment settings:
Name and Location OVFfile: C:\Users\jneo\Desktop\vscg-installer_2.5.0.1.166.0va
Host / Cluster Download size: 704.5 MB
SR%:EPM Size ondisk: 100.0 GB
Disk Format Name: Wirtual Smart Cell Gateway
Network Mapping Folder PLM Lab
Ready to Complete HostfCluster: Eng Test Bed
Datastore: datastore3

I power on after deployment

Thick Provision Lazy Zeroed
"WM Network"to "Control Network”

Help |

< Back | Finish [: I Cancel

V.

14. Make sure that the Power on after deployment check box is clear so you can adjust the network settings before the
vSZ setup.Caution: If you power on the vSZ after installation, you will no longer be able to adjust the network settings.

15. Click Finish.

ESXi deploys the new vSZ instance. When ESXi completes the deployment, the new vSZ instance appears on the list of installed

virtual machines on the target host.
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FIGURE 11 The vSZ instance appears on the list of installed VMs

vmware* vSphere Web Client ft &

4 vCenter ) X (1 vSCG1-DataCenter  Actions ~
L & B & | cettingStarted | Summary Monitor Manage Re]
w [ localhost [
~ fim Datacenter What is a Virtual Machine?
i, 10.3.3.244
v Il A virtual machine is a software computer that,
ﬁbFM_m_g_e_n_n_zﬁ (cha like a physical computer, runs an operating
EﬁFre eRADIUS (Jeanette) system and applications. An operating system

installed on a virtual machine is called a guest
5 HS20-R2_CentOS (Davi]  operating system.

(9B HS20-R2_OSU (Dave)

Because every virtual machine is an isolated
(b Novell (Jeanette)

computing environment, you can use virtual

(B portal (Jeanette) machines as desktop or workstation

) portali (Jeanette) environments, as testing environments, or to
5 12 (Jeanette) consolidate server applications.

(3p portal3 (Jeanette) In vCenter Server, virtual machines run on

Eb RuckusLabs-SCG-TME hosts or clusters. The same host can run many
Eﬁ' SCI Demo LCS (Jeanett virtual machines.

(5p VMware vCenter Server

(3p vSCG-Public SE Access V3
(5p Win2008 (Deepak)
&5 ZDVM-Public (Deepak)

You have completed creating a vSZ instance from the OVA file.

Allocating Resources and Assigning Network Interfaces

Before starting the vSZ instance for the first time, edit the virtual machine settings to allocate CPU and memory resources to the
vSZ and to assign the ESXi network interfaces to the remaining vSZ interfaces (cluster and management).

Ensure that you read steps 1-7 before starting the application.
Follow these steps to allocate resources and assign network interfaces to the vSZ.
1. On the list of virtual machines, click the new vSZ instance.

2. Click Actions to display the additional options, and then click Edit Settings.

Set the number of CPUs and the amount of RAM to allocate to the vSZ instance. By default, the OVA template is set to 4
CPUs and 8GB of RAM.

4. Under Network adapter 1, verify that it is the same ESXi network interface that you selected for the control interface
during the OVA import process. Ensure that the Connect at Power On check box is selected.
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Under Network adapter 2, select the ESXi network interface for the cluster interface from the drop-down list. Ensure

that the Connect at Power On option is selected.

Under Network adapter 3, select the ESXi network interface for the management interface from the drop-down list.
Ensure that the Connect at Power On option is selected.

FIGURE 12 Select the interfaces to use

1 vSCG1-DataCenter - Edit Settings 2
l Virual Hardware | Vi Opticns | SDRS Rules vApp Options |
v [ CPU | 4 || @
» BB MEmon 8102 v (e |~
v (4 Hard disk 1 50 = (e8 [+]
4 @d SIZ51 controller 0 L5 Lagic SAS
~ [l Network adapter 1 [ TM Mamt Metwork [ = I“
Stafus [ Connect 4t Power On Control
Adapter Trpe \ =
MAC Addrass B5d3: | dutomatic |« |
- *Network adapter 2 i"vuamnz | - i
Stalus [ connect &t Power On Cluster'
Adapter Type b
MAC Address 056:85 [ automatic |+ |
~ [ *Network adapter 3 | Public Interface [ = | -
Stalus [ Cannect & Power On Management
Adapter Type ¥
MAC Address G6A5T 58 |W
b @ Video card ; Specify cuslom settings - i
b <07 VMCI device
» Other Devices
v Upagrade [] Schedule ¥IM Compatibility Upgrade...
Mew device: e |v |
Compatioility: ESXi 5.0 and later (WM versicn 8) 0K Cancel

7. Click OK. You have completed allocating resources and assigning network interfaces to the vSZ.
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Powering on the vSZ virtual machine

The next step is to power on the vSZ virtual appliance.

1. From the list of virtual machines on the host, click the vSZ instance.
2. Under Basic Tasks, click Power on the virtual machine.

FIGURE 13 Click Power on the virtual machine

&1 vSCG1-DataCenter »
G5jp Win2008 (Deepak)

{5 ZDVM-Public (Deepak)
Basic Tasks Explore Further

[l Power on the virtual machine Learn how to install a guest
operating system

Learn more about virtual
machines

Learn about templates

(3 Edit virtual machine settings

3. Open a console window to monitor the startup process. To do this, click the Action menu, and then click Open Console.

After the vSZ completes its startup process, you are ready to perform the initial IP address setup of the vSZ. You will use
the console connection to perform this task.

Installing the vSZ on Windows Server Hyper V

Before you begin, verify that Hyper-V is enabled on Windows Server. Follow these steps to install the vSZ on Windows Server
Hyper-V.

1. Obtain a copy of the vSZ image in VHD format.
Extract the vSZ image to the .vhd disk file.
Copy the image to the Windows Server on which you are running Hyper-V.

A WD

On the Windows Server, click Start > Administrative Tools, and then double-click Hyper-V Manager.
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5. Inthe Hyper-V Manager, select the Hyper-V core for which you want to create a virtual machine and click Virtual
Machine > Action > New > New Virtual Machine Wizard. The appears and displays the Before You Begin screen.

FIGURE 14 Click Action > New > Virtual Machine

File  Action

Wiew  Help

&= #E B

=5 Hyper- Manager

i: | Mew

Wirtual Machine..,

Irmport Virkual Machine...

Hyper-t Settings...
Wirtual Switch Manager..,
Wirtual 38N Manager..,

Hard Disk...
Floppy Disk...

b

Edit Disk...
Inspect Disk..,

Stop Service
Rernaove Server

Refresh

Wi

Help

CPU Usage Assighed Mermory

ines were found on this server

L

T
L<]

Checkpoints

| Actions

Details

Mo item selected.

<

was s

Mesnr
Irnport Virkual Machine..,

Hyper-Y Settings...

« VWirtual Switch Manager.,

Wirtual 34N Manager..,
Edit Disk...

Inspect Disk..,

Stop Service

Rernowve Server
Refresh

Wik

Help

Displays the Mew Yirtual Machine Wizard,
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6. Click Next. The Specify Name and Location screen appears.

FIGURE 15 The New Virtual Machine Wizard screen

e New Yirtual Machine Wizard -

[ *.’ Before You Begin

This wizard helps wou create a virtual machine, ¥ou can use virtual machines in place of physical
computers For & variety of uses, You can use this wizard ko configure the virbual machine now, and
vou can change the configuration later using Hyper-Y Manager,

Specify Mame and Location

Specify Generation
[P To create a wirtual machine, do one of the Following:

Assign Mermory
. ) + Click Finish ko create a virtual machine that is configured with default values,
Configure Networking » Click Mext bo create a wirtual machine with a custom configuration,

Connect Virtual Hard Disk
Installation Options

Surnmary

Do mot show this page again

Mext = | | Firish | | Zancel
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7. In Name, type a name for the virtual machine that you are installing (for example, Virtual SmartZone).

FIGURE 16 Specify Name and Location

e Mew Virtual Machine Wizard -
[ . .
[ kn Specify Name and Location
.L'i!f i
Before You Begin Choose a name and lacation Far this virtual machine,

The name is displaved in Hyper-Y Manager, We recommend that vou use a name that helps vou easily
Sperify Generation identify this wirtual machine, such as the name of the guest operating syskem or workload.

Assign Memory Mame: |'\.-'52|

configure Metworking ‘o can creake a Folder or use an existing folder to store the virtual machine, IF vou don't select a

Connect Virtual Hard Disk folder, the virtual maching is stored in the default Folder configured For this server,
Installation Options [] store the wirtual machine in a different location
Surnrmary C:\ProgramDatalMicrosoftiwindows\Hyper -
)
< Previous | | Mexk = | | Finish | | Cancel

8. Specify the folder on the server where you want to install the virtual machine.

a) Toinstall the virtual machine in the default location, make sure that the Store the virtual machine in a different
location check box is clear.

b) To install the virtual machine in a location other than the default, select and Store the virtual machine in a different
location check box, and then browse to or type the new location.
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9. C(lick Next. The Specify Generation screen appears.

FIGURE 17 Specify Generation

e Mew Virtual Machine Wizard
| . .
i *. Specify Generation
.I_;#‘ i
Befare Wou Begin “hoose the generation of this virtual machine,
Specify Mame and Location ® Generation 1

previous wersions of Hyper-y,

Assign Mernory

Configure Metworking () Generation 2

Connect Yirtual Hard Disk This wirtual machine generation provides support For Features such as Secure

This wirtual machine generation provides the same virtual hardware ba the wirtual maching as in

P*E boot using a standard network adapter. Guest operating swstems musk be running at least

Book, 331 book, and

Installation Cptions windows Server 2012 or 64-bit versions of Windows 8,
SUnAiMmary /1, Once a virbual machine has been created, you cannot change its generation,
< Previous | | Mext = | | Finish | | Zancel

10. Select Generation 1 for the virtual machine that you are installing. Hyper-V offers Generation 1 and Generation 2. See

the Hyper-V documentation for more information about these two generations.

34
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11. Click Next. The Assign Memory screen appears.

FIGURE 18 Assign Memory

i Mew ¥Wirtual Machine Wizard -
| .
[ kn Assign Memory
.L'i!f i
Before You Begin Specify the amaount of memary to allocate to this virtual machine, You can specify an amounk from 32

ME thraugh 29250 ME. To improve performance, specify more than the minimum armount recommended
for the operating syskem,

Specify Generation Skartup rernory: |15E|E|D ME

Specify Narme and Lacation

Assign Memory

[ Use Cynamic Mermory For this virkual machine,
Canfigure Mebwarking

Cannact Yirtual Hard Disk .;ﬁ] ‘When you decide how much remory bo assign ko 5 wirkual machine, consider how vou inkend to

use the virtual machine and the operating system that it will run,
Inskallation Qpkions

Surnmary

< Previous | | Mexk = | | Finish || Cancel

12. In Startup memory, type 13GB for vSZ High Scale or 15GB for vSZ Essentials (as relevant), which are the minimum
memory that Ruckus Networks recommends for deploying vSZ. You can type a higher value if more memory is available
on the server. For more information, see Table 4 and Table 5.
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13. Click Next. The Configure Networking

FIGURE 19 Configuring Network

s Mewy Yirtual Machine Wizard -
| .
[ | Configure Networking
.b’.' o
Before YYou Begin Each new virtual machine includes a network adapter. You can configure the network adapter ko use a

wirkual switch, or it can remain disconnecked.
Specify Name and Location !

Specify Generation Connection: | ws-brz v

Assign Mermoary

Conneck Wirkual Hard Disk
Installation Options

Summary

< Previous | | Mext = | | Finish | | Zancel

14. In Connection, select the network adapter that you want the virtual machine to use.
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15. Click Next. The Connect Virtual Hard Disk screen appears.

FIGURE 20 Connect Virtual Hard Disk

i Mew Virtual Machine Wizard -
| . .
A kl Connect Virtual Hard Disk
ab’.' i
Before You Begin # wirkual raching requires storage so that you can install an operating system, You can specify the

Specify Mame and Location storage now or configure it laker by modifving the virtual maching’s properties.

Specify Generation () Create a virtual hard disk

St ey |Jse this option to create a YHDY dynamically expanding virkual hard disk,

Configure Metwarking wSZ . whdx

CserstPubliciDocumentsiHyper-wWirtual Hard Disks',

Surmary

127 | GB (Maximum: &4 TB)

(®) Use an existing virtual hard disk.

|Jse this option to attach an existing virtual hard disk, either WHD or YHDY Farmat,

[Tl Tel N Ll ser s Publici Document siHyper-virkual Hard Disks || Browse, .,

() Akkach a virtual hard disk later

Idse this option ko skip this step now and atkach an existing virkual hard disk later,

< Previous Cancel

16. Select Use an existing virtual hard disk.
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17. Click Browse to specify the location of the existing virtual hard disk for the virtual machine to use.

FIGURE 21 Selecting Virtual Hard Disk

Organize ~

1M ylab

ﬁ Microsoft Managerne wscg-340.0.238vhd
40.0 GB

T |_L| <« Cit v users » public » Documents » hyper-v » Virtual hard disks

] Gl | Search Virtual hard disks r |

B

-0 @

File name: [vscg-3.4.0.0.238.vhd

v |virtual hard disk files

V]

o ] |

Cancel |
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18. Click Next. The Completing New Virtual Machine Wizard screen appears.
FIGURE 22 Completing New Virtual Machine Wizard

e Mew Yirtual Machine Wizard -

[ *.’ Completing the New Virtual Machine Wizard

Before You Begin ¥ou have successfully completed the Mew Wirtual Machine Wizard. You are about to create the

Following wirtual hine,
Specify Mame and Location aiawing wirtual maching

Specify Generation BeScibtiny:

Assign Mernmory Mame: w3z

Generation:  Generation 1

Memory: 15000 MB

Mekwark: wa-brZ

Summaryy Hard Disk:  CriusersipubliciDocumentsihyper-wivirtual hard diskstwscg-3.4.0,0,238 vhd (WHD, Fixe

Configure Networking

Connect Yirtual Hard Disk,

£ m >

To create the virkual machine and close the wizard, click Finish,

Finish | | Zancel

19. Review the settings that you can configure for the virtual machine. If you find any setting that need to be changed, click
Previous until you reach the screen where you can update the setting. Update the setting, and then click Next until the
Completing New Virtual Machine Wizard screen appears again.
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20. Click Finish to install the virtual machine. When Windows Server completes installing the virtual machine, the New
Virtual Machine Wizard disappears and the virtual machine you installed appears on the list of virtual machines on

Hyper-V Manager.

FIGURE 23 The virtual machine you installed appears on the list of virtual machines on Hyper- V Manager

= Hyper-¥ Manager = [ = -

File  Action ‘Miew Help

@ %[m 3

= Hyper-v Manager Actions
“FRE] Virtual Machines
53 WIN-BTWERLIAMHLI Tl =
EE ) Marme State CPU Usage Agsigned Memory L Mew »

R off

< m

Chedkpoints

Lz Irnpaort Virtual Machine...

Hyper- Settings...

FT Virtual Switch Manager...

) Virtual SAN Manager...
g Edit Disk.,
H Inspect Disk...

| Stop Service

C
75 Rermove Server
i Refresh

Wi

E Help

Ruckus Virtual SmartZone Getting Started Guide

Part Number: 800-71961-001 Rev A



21. Right-click the virtual machine you installed, and then click Start to power on the virtual machine.

FIGURE 24 Right-click the virtual machine, and then click Start

File  Action  View Help

Installing the vSZ on a Hypervisor
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The Virtual Machine Connection screen appears.
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FIGURE 25 Virtual Machine Connection
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Starting syslog-ng: [ OK 1
alling the system activity data collector (sadc):

Starting monitoring for UG uwgh@: 1 logical volume(s) in wolume group “vgBd"
oK 1

ipotables: Applying firewall rules: [ OK 1
iptables: Applying firewall rules: [ OK 1
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ik vSZ on WLAB - Virtual Machine Connection = [ = -
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22. Login to the virtual machine with your credentials.

You have now completed installing the vSZ on Windows Server Hyper-V.

This section describes how to install the vSZ on a KVM hypervisor.

The vSZ image for a kernel-based virtual machine (KVM) is distributed in QCOW2 format.
1. Obtain the vSZ image in QCOW?2 format.
2. Copy the image to the KVM.
3. Open the terminal window.

a2

[ =0 EXpOf.,
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4. Make the image bin file executable by entering the following command: chmod +x {file name of the controller QCOW
bin} See Figure for an example.

FIGURE 26 Make the bin file executable

Oc numbersix@toaster: ~

numbersix@toaster:~% chmod +x vscg—3.1.1.0.442.qcow2.binl

5. Extract the contents of the QCOW?2 bin file.

FIGURE 27 Extract the contents of the QCOW2 image

(] numbersix@toaster: ~

numbersix@toaster:~$ chmod +x vscg-3.1.1.0.442.qcow2.bin
numbersix@toaster:~$ ./vscg-3.1.1.0.442.qcow2.bin|

The end user license agreement appears on screen.
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At the Accept this agreement? [yes/no] prompt, enter yes.

FIGURE 28 Accept the EULA terms

numbersix@toaster: ~

withheld. This agreement may be executed simultaneously in any number of
counterparts, each of which will be deemed an original, but all of

which together constitute one and the same agreement. The parties agree
that electronic signatures are valid signatures for enforcement of

this agreement. This agreement constitutes the entire agreement between
Ruckus and Licensee with respect to the subject matter hereof.

This agreement supersedes all prior negotiations, agreements and underta
kings between the parties with respect to such subject matter. As a

matter of clarity, the preceding two sentences do not affect either part
v’s obligations regarding confidential information under any other

agreement between the parties. Mo modification of this agreement will be
effective unless contained in writing and signed by an authorized

representative of each party. Notwithstanding applicable law, electronic
communications will not be deemed signed writings. Any additional

orders for licenses hereunder shall be governed by the terms of this Agr
eement. No term or condition contained in Licensee’s purchase order

or similar document will apply unless specifically agreed to by Ruckus i
n writing, even if Ruckus has accepted the order set forth in such

purchase order, and all such terms or conditions are otherwise hereby ex
pressly rejected by Ruckus. In the event of a conflict between this

agreement and any other applicable agreement, this agreement shall gover
n.

Accept this agreement? [yezfno]:l

The KVM continues to extract the contents of the image. When the extraction process is complete, the QCOW?2 file
appears in the same directory as the .bin file.

FIGURE 29 The QCOW?2 file appears in the same directory as the .bin file

Places Name =~ size Modified

Qsearch [ Desktoj 1313
P
@ Recently Used % Documents 1313
ly
|8 numbersix 3 Downloads 13:21
0 Desktop & Music 13:13
(3 File system @ Pictures 13:47

= 285GB Volume &3 Public 13:13
5 Templates 1313
i@ videos 13:13

examples.desktop 9.0kB  12:55

[ Documents
& Music

@ Pictures
i@ videos

& Downloads

Vvscg-3.1.1.0.442.qcow2.bin 876.8MB 13:21

NOTE
If the “uudecode: command not found” error appears during the extraction process, install the “sharutils”
package on the KVM, and then try extracting the image again.
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7. Resize the vSZ disk image, if necessary. By default, the vSZ disk size is 50GB. If you want to allocate more disk space to
the vSZ, run the gemu-img command. The complete syntax is as follows: gqemu-img resize {file name of the controller
QCOW bin} +size
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Setting Up the vSZ

You can set up the vSZ using the Red Hat Virtual Machine Manager (also known as “virt-manager”). If you are installing the vSZ on
a different hypervisor or virtual machine monitor, the procedure may be slightly different. Refer to the hypervisor
documentation for more information.

1. Start the Virtual Machine Manager by clicking Applications > System Tools > Virtual Machine Manager. Or double-click
the Virtual Machine Manager icon if it appears on the desktop. The Virtual Machine Manager interface appears.

FIGURE 30 The Virtual Machine Manager interface

Virtual Machine Manager
E—J Open w

MName =

localhost (QEMLU)
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2. InFile, click Create New VM. Or click the New VM icon. The New VM screen appears

FIGURE 31 The New VM

Virtual Machine Manager
IE| Open

m Create a new virtual machine

Enter your virtual machine details

Name:
Connection: localhost (QEMU/KVM)

Choose how you would like to install the operating system
@® Localinstall media (ISO image or CDROM)
() Network Install (HTTP, FTP, or NFS)
) Network Boot (PXE)

) Import existing disk image

Cancel Back Forward
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3. Configure the options on the New VM (Step 1 of 4) screen.
a) In Name, type a name that you want to assign to the virtual machine.
b) In Choose how you would like to install the operating system, click Import existing disk image.

FIGURE 32 Type a name and select how you want to install the operating system

Virtual Machine Manager

|__E-_| Open

m Create a new virtual machine

Enter your virtual machine details
Name: |vSZ3-1-1
Connection: localhost (QEMU/KVM)

Choose how you would like to install the operating system
) Local install media (ISO image or CDROM)
) Network Install (HTTP, FTP, or NFS)
() Network Boot (PXE)

@® Import existing disk image

Cancel Back Forward

4. Click Forward. The Locate Existing Storage dialog box appears.
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5. Browse to the location of the vSZ QCOW2 image, select the image file, and then click Open. The New VM (Step 2 of 4)
screen reappears and displays the storage path to the QCOW2 image file that you selected.

FIGURE 33 Browse to the vSZ QCOW?2 image

Locate existing storage

Name: |.vscg—3.1.1.0.442.qcow2 |
Saveinfolder: | 4 | ﬁnumbersix] | Create Folder |
Places Name 4  Size Modified
@, search Bl Desktop 13:13

@ Recently Used [T Documents 13:13

@ numbersix |Zi Downloads 13:21

B Desktop [ Music 13:13

3 File System |[® Pictures 13:47

2 285 GB Volume [#4 Public 13:13

[ Documents e} Te.mplal:es 13:13

i Music [@ videos 13:13

@ Pictures examples.desktop 9.0kB 12:55

i@ videos B vscg-3.1.1.0.442.qcow? 23GB  15-06-25
@ Downloads . vscg-3.1.1.0.442.qcow2.bin 876.8MB 13:21

| Cancel I.%
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6. Inthe lower portion of the New VM (Step 2 of 4) screen, select the operating system type and version.
a) In OS type, select Linux.

b) In Version, select Generic 2.6.x kernel.

FIGURE 34 Select the operating system and version

Virtual Machine Manager
|__E-_| Cpen

m Create a new virtual machine

Provide the existing storage path:

/home/numbersix/vscg-3.1.1.0.442.qcow?2 Browse...

Choose an operating system type and version

OS type: | Linux -
Version: | Generic 2.6.x kernel -
Cancel Back Forward

7. Click Forward. The New VM (Step 3 of 4) screen appears.
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8. Configure the memory and CPU settings of the virtual machine.
a) In Memory (RAM), set to memory (in MB) that you want to allocate to the vSZ.
b) In CPU, set the number of CPUs that you want to allocate to the vSZ.

FIGURE 35 Configure the memory and CPU settings

Virtual Machine Manager

|__E-_| Open

m Create a new virtual machine

Choose Memory and CPU settings

o

Memory (RAM): | 1930 . MB
Up to 3865 MB available on the host

o

CPUs: 2|+
Up to 4 available

Cancel Back Forward
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Installing the vSZ on a Kernel based Virtual Machine Hypervisor

9. Click Forward. The New VM (Step 4 of 4) screen appears and displays a summary of the settings you configured.

FIGURE 36 A summary of the settings you configured appears
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10.

11.
12.

Installing the vSZ on a Hypervisor
Installing the vSZ on a Kernel based Virtual Machine Hypervisor

Verify that the settings you configured on the previous screens are correct. If you need to make changes to any of the
settings, click Back until you reach the screen on which the setting appears, make the change, and then click Forward
until you reach the New VM (Step 4 of 4) screen again.

Click Finish to install the vSZ on the virtual machine.

After you complete installing the vSZ on the virtual machine, decide how many interfaces you want the vSZ to use. The
VSZ supports either a single interface or three interfaces. By default, a single interface exists after installation.

* If you want the vSZ to use a single interface, you do not need to take action in this step. Continue to the next step.

* If you want the vSZ to use three interfaces, you must create the two additional interfaces before the initial bootup of
the vSZ. Once the vSZ has completed its initial bootup, you will no longer be able to change the number of
interfaces.

If you want to add interfaces, you must do so before the initial bootup of the vSZ. After the initial bootup, you will no
longer be able to change the number of interfaces.

FIGURE 37 By default, a single interface exists
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|
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EF Controller IDE

Redirected USB
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13. Power on the virtual machine. The vSZ performs its initial bootup.

14. When the vSZ login prompt appears, enter admin.

You have completed setting up the vSZ on a KVM hypervisor. You are now ready to start the vSZ Setup Wizard. See Using the
Setup Wizard to Install vSZ for more information.
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Installing the vSZ on Microsoft Azure

© INEFOAUCTION ettt b et b etttk b ettt b ettt 55
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* Creating @ RESOUICE GIOUP...cuiiiiiiiieieeteie ettt sttt b e st st b e et s bt b e s hs e b e b e sbe st e e b e et e saeesbesibesbeeanenas 57
«  Creating a Storage ACCOUNT @NA CONTAINET ....c.coueirieririeirieitriett ettt ettt sttt ettt e e ebe e ebe e ebeeebenene 60
« Uploading the VSZ IMage t0 MIiCrOSOTT AZUIE......ccucirieirieieieieieiesiei ettt ettt sttt a et saeaenaenens 65
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«  Updating the Disk Size According to RESOUICE PlaN.......ccveiiiiinieiinieiiieesieeieeeteeie ettt 87

Introduction

You can install vSZ on Microsoft Azure using the procedure outlined.

NOTE

The minimum memory and CPU requirements have changed in this release. You may need to upgrade your
infrastructure before upgrading. Please read carefully. This is the minimum requirement recommended. Refer to the
tables in GUID-01F2862D-ABB3-4B66-9011-171D53EB555B in the Installation Preparation chapter.
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Installing the vSZ on Microsoft Azure

Logging into Microsoft Azure

Logging into Microsoft Azure

As the first step of installing vSZ on Microsoft Azure, you have to log into Microsoft Azure.

Click https://portal.azure.com to access the Microsoft Azure site.

The Azure portal appears as shown in the following image.

FIGURE 38 Portal Tab
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Creating a Resource Group

Creating a Resource Group

To create a resource group:

1. From the left pane of the Microsoft Azure page, click Resource groups. The Resource groups page appears with the
list of existing resource groups as shown in the following image.

FIGURE 39 Resource Groups
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Creating a Resource Group

2. Click the Add + button and enter the Resource group name as shown in the following image.

FIGURE 40 Adding Resource Group Name
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Installing the vSZ on Microsoft Azure
Creating a Resource Group

3. Click Create and select the resource group from the list as shown in the following image.

You can view the list of related components of the selected resource group.

FIGURE 41 Resource Group Components

nolan.ouyang

and docs = © 6 B

h resources,

Create a resource

All services

RITES

Resource groups
Ruck

Edit columns

o More

Ruckus Virtual SmartZone Getting Started Guide
Part Number: 800-71961-001 Rev A

Nolan_5.0_betal

Resource group

) Overview

«

+

Subscript
Pay-As-Y

dit columns [ Delete resource group ) Refresh

Subscrip
be38222

D
7829-4256-0ba8-5a2eT...

= Move 9

Deployments
3 Failed,

Dashboard NAME B Activity log
All resources () cloud-shell-storage-centralindia i Access control (IAM)
Default-Networking ., Alltypes v | | Atocations »
Resource groups ’ ¢ # T
(@) Default-SQL-JapanEast A0 items
- Events. .
App Services X )
Default-Storage-EastAsia NAME TYPE LOCATION TAGS
Function Apps Default-Storage-EastUS SETTINGS 360.00510 Image East Asia
= 5QL databases (@) Default-Storage-Japaniest Quickstart 5.0.0.0.249 Image East Asia
) Default-Storage-SoutheastAsia D Resource costs . Asia
ure Cosmos DB @ 5000505 Image East Asia
Default- St -WestUS
J Default-Storage-West e Deployments A 5000524 Image East Asia
Virtual machines )
mms-cus s Asia
: Palicies 3 5.0.0.0.610 Image East Asia
Load balancers — 5.0.0.0.668 Image East Asiz
= Properties -
|| Srreemms ArEaL el a S3 5-0-0-0-668-fresh_disk]_7258¢f9979fe4acIBedT1cB2092 Disk East Asia
— Locks
i ) san-vsz-nodel B sooo0s66smeshsis Network interface EastAsia
Virtual networks @) s o stomation scrnt
) scaling-asa = nutomation s 5-0-0-0-668-fresh-ip Public IP address East Asia
Azure Active Directory scaling-sim01-G Asia
k MONITORING [ 50-0-0-668-fresh-nsg Network security group East Asia
Monitor ) scaling-sim02-W N £ Nolan-5-0-0-0-249_diskl_21abe2eed0984234be33450faa-  Disk East Asia
o erts
scaling-sim03-R . Asia
Advisor ) B nolan-5-0-0-0-249403 Network interface East Asia
3
) 5235 Nolan-5-0-0-0-249-ip Public IP address East Asia
Security Center @) tdc-abe-
J tdc-abe-grafana O Nolan-5-0-0-0-249-nsg Netwerk security group East Asia
Cost Management + B... ) tde-abe-resource Bl Diagnostic settings 3 nolan50betal Storage account East Asia
-abe-si 01 -
s tdc-abe-simpc £ Logseard nolan50betaldiagd79 Storage account East Asiz
tdc-abe-simpc03
(7 tdc-abe-simpd $ Aduisor recommendsti Nolan50beta2upgrade Virtual machine East Asia Owner: Nolan
Network security grou... @) tebilmet
W87 tdebillne e =2 Nolan50b o disk] 41897dfff 6edd29b - Disk Fast dsin

59



Installing the vSZ on Microsoft Azure
Creating a Storage Account and Container

Creating a Storage Account and Container

To create a Microsoft Azure storage account, perform the steps outlined in this section.

1. From the left pane of the Microsoft Azure page, click Storage accounts. The Storage accounts screen appears.

FIGURE 42 Creating a storage account
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Installing the vSZ on Microsoft Azure
Creating a Storage Account and Container

2. Click Add and perform the following:
* Enter a Name using lowercase alphanumeric characters.

* In Deployment model, select Resource manager; it is new method to manage storage. If you select Classic mode,
the vhd file allows to use only powershell to do upload.

* In Replication, select Locally-redundant storage (LRS)

* In Resource group, choose Use Existing and select the resource group from the drop-down.
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FIGURE 43 Storage Account
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3. Click Create.
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Installing the vSZ on Microsoft Azure
Creating a Storage Account and Container

4. Select the storage account from the list and select Blobs for uploading the vhd file as shown in the following image.

FIGURE 44 Blobs for Uploading
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Creating a Storage Account and Container

64

5.

Click + Container, enter a Name and click OK as shown in the following image.

FIGURE 45 Adding Container
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Uploading the vSZ Image to Microsoft Azure

You have to upload the vSZ image to Microsoft Azure. Follow these steps outlined in this section to upload the vSZ image to

Microsoft Azure.

1. Select the newly created container from the list and click Upload as shown in the following image.

FIGURE 46 Uploading the vSZ image
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Uploading the vSZ Image to Microsoft Azure
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2. From the right pane, click the folder to choose the .vhd file from the local PC and click Upload.
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Creating a Virtual Network

Creating a Virtual Network

Follow these steps to create a virtual network.

1.

66

From the left pane of the Microsoft Azure page, click Virtual Networks as shown in the following image.

FIGURE 47 Creating a virtual network
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Installing the vSZ on Microsoft Azure
Creating a Virtual Network

2. Click Add and update the following:
* Name: enter a name for the network
* Address space: enter the network address
* Resource group: choose the Use existing option and select the existing resource group from the drop-down.

* Address range: enter the address range.
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FIGURE 48 Virtual Network Details screen
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3. Click Create, you have created a network.
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Creating Network Security Groups

Network security group is the Azure firewall rule. You can have different firewall rules for each vSZ instance.
To create a network security group:

1. From the left pane of the Microsoft Azure page, click Network security groups. The Network security groups page
appears with the list of existing resource groups as shown in the following image.

FIGURE 49 Network security Groups

Create a resource

Al services . P
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RITES
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= <0 -
#  SQL databases O Nolan50beta2upgrade-nsg Nolan_5.0_betal East Asia Pay-As-You-Go
) @ ET @ nolan-beta2-524-nsg Nelan_5.0_betal East Asie Pay-As-You-Go
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Storage accounts @ tdcabevszNSG tdcaberesourcegroup East Asia Pay-As-You-Go
@ tde-nolan-nsg Nolan_5.0_betal East Asia Pay-As-You-Go

Virtual networks
Azure Active Directory
Monitor

* Advisor

Security Center

© Cost Management + Billing

Help + support
Network security groups

@ 1mages
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2. Click Add and update the following:
¢ Name: enter a name for the network

* Resource group: choose the Use existing option and select the existing resource group from the drop-down.
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3.

—I— Create a resource
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FIGURE 50 Adding Resource Group Name

Network security groups
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4.

Select the network security group from the list and click Inbound security rules as shown in the following image.

The existing rules are listed.

FIGURE 51 Inbound security rules
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DESTINATION
VirtualNetwork
Internet

Any

ACTION
@ Allow
@ Allow
@ Allow
@ Allow
@ Allow
@ Allow

© Deny

ACTION
@ Allow
@ Allow

© Deny

Ruckus Virtual SmartZone Getting Started Guide
Part Number: 800-71961-001 Rev A



5. Click Add + to create a new rule as shown in the following image.

The existing rules are listed.

FIGURE 52 Creating security rules
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SUPPORT + TROUBLESHOOTING

L Effective s

ty rules

New support request

73



Installing the vSZ on Microsoft Azure
Creating Network Security Groups

6. From the Add inbound security rule page update the following fields:
* Source: select the source port.
*  Source port ranges: enter the source port range.
* Destination: select the destination port.
* Destination port ranges: select the destination port ranges.
*  Protocol: select one of the options—Any, TCP or UDP.
*  Action: select Allow or Deny.
*  Priority: enter the rule priority number.
* Name: enter a name for the rule.

* Description: enter a short description about the rule.

FIGURE 53 Adding Inbound Security Rule
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7. Click Add, the new rule is added to the existing rule list as shown in the following image.

The existing rules are listed.

FIGURE 54 Inbound Security Rule List
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Creating a vSZ Image on Microsoft Azure

Follow these steps to create a vSZ image on Microsoft Azure:

1. NOTE
ssh is allowed by default, so add port 443 and 8443 for AP connection and Web access.

From the Microsoft Azure page, click Images.
FIGURE 55 Creating an image

Azure > 8O0 e

e > Im

Create a resource Images

Al services Editcolumns ) Refresh

Subscriptions: Pay-As-You-Go

[ All resource groups « | [ Alllocations « | [ No grouping -«
Dashboard
8items
B Al resources NAME SOURCE VIRTUAL MAC... 05 TYPE RESOURCE GROUP LOCATION ZONE RESILIENT SUBSCRIPTION
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P 3610222 - Linux Alon-Resource East Asia No Pay-As-You-Ga
% Function Apps
4 5.00.0.249 - Linux Nolan_5.0_betal East Asia No Pay-As-You-Go
SQL databases 2 5000505 - Linux Nolan_5.0_betal East Asia No Pay-As-You-Go
P Azure Cosmos DB 8 5000524 - Linux Nolan_5.0_betal East Asia No Pay-As-You-Go
@ 5000610 Nolan_5.0_betal East Asia Pay-As-You-Go.
Virtual machines
P 5.00.0668 Nolan_5.0_betal East Asia Pay-As-You-Ga

Load balancers
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Azure Active Directory

Monitor

» Advisor

‘Security Center
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2. Click Add, the Create image page appears as shown in the following image.

FIGURE 56 Create an Image from VHD

Create a resource
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Dashboard
HE Al resources

#| Resource groups

. App Services

¥ Function Apps
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! Virtual machines

*‘ Load balancers
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Virtual networks
Azure Active Directory
Monitor

* Advisor

Security Center
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U Search resources, services, and docs

image
Images « A X Create image
Ruc n
4 Add S8 Edit columns More * Name
[
* Subscription
NAME Pay-As-You-Go
36.0.0.0510 * Resource group
3 160025 (®) Create new () Use existing
B 3610222 The value should not be empty.
2 5000249 * Locatio
B 5000505 East Asiz
@ 5000524
A 5000610
5.0.0.0.663

3. Update the following fields:

|

= Account type @
Standard HDD

* Host caching @
Read/write

Data disks

+ Add data disk

* Name: enter a name for the image.

* Resource group: choose Use existing and select the option from the drop-down.

*  OS type: choose Linux.

* Storage blob: click Browse and select the file.
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4. Click Create, the Storage accounts page appears as shown in the following image.

FIGURE 57 Storage Account List

ices, and docs
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% SQL databases dtest2166 Standard-LRS testrg435559
& Azure Cosmos DB dtestag37 Standard-LRS testrg624768
[ T — nolanS0betal Standard-LRS Nolan_5.0_betal
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5. Select the Storage account from the list, the Containers page appears as shown in the following image.

FIGURE 58 Select the Container
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6. Select the Container from the list, the images in the container are listed as shown in the following image.

FIGURE 59 Images in the Container
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| Create a resource
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- vseg-5.0.0.0.505.vhd Page blob 40 GiB Available
= SQL databases
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7. Select the image file from the list and click Select. The selected image is listed in the Images page as shown in the
following image.

FIGURE 60 Images Page
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@ 3610222 - Linux Alon-Resource EastAsia No Pay-As-You-Go
%> Function Apps
@ 5000249 - Linux Nolan 5.0_betal EastAsia No Pay-As-You-Go
= SQL databases @ 5000505 - Linux Nolan_5.0_betal EastAsia No Pay-As-You-Go
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8. Select the image and click Create VM as shown in the following image

FIGURE 61 Create VM
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9. From the Create virtual machine page select the Basics tab and update the following:

Name: enter a name for the virtual machine.

VM disk type: select HDD form the drop-down as disk type.
User name: enter a username for the virtual machine.
Authentication type: choose the preferred authentication type.
Password: enter the password.

Confirm password: re-enter the password.

Resource group: choose Use existing and select the resource group from the drop-down.
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FIGURE 62 Basics Information
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10. Click OK, the Settings tab page appears as shown in the following image.

FIGURE 63 Settings Tab
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11. Select the Network and security group information and click OK. The Summary page appears as shown in the following

image.
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Updating the Disk Size According to Resource
Plan

Follow these steps to update the disk size according to the resource plan:

1. From the Virtual Machines page, select the Virtual Machine and click Stop ass shown in the following image.

FIGURE 65 Stopping the Virtual Machine

Microsoft Azure P Search resources, services, and docs

Home > Virtual machines

Create a resource Virtual machines
ARRIS Group, Inc.
All services

== add (D Reservations Edit columns € Refresh ® sssigntags P ostart QY Restart @ Delete = Services
FAVORITES

Subscriptions: All 2 selected - Don't see a subscription? Open Directory + Subscription settings
Dashboard

Al subscriptions ~ | | Al resource groups ~ || Alltypes ~ | | Alllocations ~ | | Alltags

All resources

1 of 22 items selected

# Resource groups
m| NAME TYPE STATUS RESOURCE GRO... LOCATION MAINTENANCE... SUBSCRIPTION PUBLICIP ADD...

5 App Services

v BN s5-1-upgrade tdc-nolan-resource  East Asia = Pay-As-You-Go - A.. -

%> Function Apps

5-1-upgrade-node2 virtual machine Stopped (deallocated) tdc-nolan-resource  East Asia - Pay-As-You-Go - A..

% sQL databases o
& Azure Cosmos DB @ auto-bdc-srr-1 Virtual machine (cla.. Running auto-bdc-srvr-1 East Asia - Pay-As-You-Go - R... Mot supported
B virtual machines auto-bdc-srvr-2 Virtual machine (cla.. Running auto-bdc-srvr-2 East Asia - Pay-As-You-Go - R... Mot supported
& Load balancers @ bill-simpc-01 Virtual machine (cla..  Stopped (deallocated) bill-simpc-01 East Asia - Pay-As-You-Go - R... Not supported
B storage accounts @ bill-simpc-02 Virtual machine (cla.. Stopped (deallocated) bill-simpc-02 East Asia - Pay-As-You-Go - R... Not supported
Virtual networks bill-simpc-03 Virtual machine (cla.. Stopped (deallocated) bill-simpc-03 East Asia - Pay-As-You-Go - R... Mot supported
& Azure Active Directory A riley-simpc-01 Virtual machine Stopped (deallocated) riley-simpc East Asia - Pay-As-You-Go - A..
g Monitor B riley-simpc-02 Virtual machine Stopped (deallocated) riley-simpc East Asia - Pay-As-You-Go - A...
e B3 riley-simpc-03 Virtual machine Stopped (deallocated) riley-simpc East Asia - Pay-As-You-Go - A...
& Security Center @ scaling-aaa0l Virtual machine (cla.. Running scaling-aaa01 East Asia - Pay-As-You-Go - R... Not supported
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2. From the Settings area, select Disks and select the Virtual Machine as shown in the following image.

FIGURE 66 Disk Settings

Microsoft Azure P Search resources, services, and docs

Home 3 Virtual machines > 5-1-upgrade-node2 - Disks
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& App Servi € Tags 05 disk
App Services upgrade-nodez s
% Function Apps @] auto-bdc-srvr-1 ¥ Diagnose and solve problems NAME SIZE STORAGE ACCOU... ENCRYPTION HOST CACHING
% SQL databases &] auto-bdc-srvr-2 Settings 5-1-upgrade-node?_diskl_67061c60ab9342aebdd3edda7..| 40 Gig Premium SSD Mot enabled Read/urite
& Azure Cosmos DB %] bill-simpc-01 Networking
8 virtual machines | bill-simpc-02 Data disks
None
4 Load balancers @] bill-simpc-03 D Size
Virtual networks A riley-simpe-02 7 Extensions
@ Azure Active Directory & riley-simpc-03 @ Continuous delivery (Preview)
© Monitor | scaling-asao1 Availability set
@ advisor 2 tdc-aaa-server & Configuration
W security Center &] tdc-abe-simpcol Identity
© Cost Management + Billing 3 tdc-abe-simpcoL Properties
-
M Help + support @A tdcabevsz a Lods
= Images [ tdc-grafana £ Automation script
W Network security groups A tdc-license-server Operations
& Recovery Services vaults riley-vsz-e-51- ;
Ty & tde-riley-vsz-e-51-nodel O Auto-shutdown
$ subscriptions A tde-riley-vsz-e-s1-nodez & Backup
%] ysz-auto-bdc-
vsz-auto-bde-l & Disaster recovery
@] vsz-auto-bdc-3 -

B Update management
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3. From the left pane select Configuration, enter the disk Size (GB) and click Save as shown in the following image.

FIGURE 67 Disk Size

Microsoft Azure P Search resources, services, and docs _

Home > Virtual machines > 5-1-upgrade-node2 - Disks * 5-1-upgrade-node2_diskl_67061c69ab9942aebdd3ed9a7c6105d5 - Configuration
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Disk
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FAVORITES - b—_—— e
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& App Services # Tags
rs . ESTIMATED PERFORMANCE @
7> Function Apps Settings
- 10PS limit 2300
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& Configuration Throughput limit (MB/3) 150
’ Azure Cosmos DB A Disk Export |
! Virtual machines 8 Locks
@ Load balancers i Automation script

= storage accounts
= Support + troubleshooting

Virtual networks
New support request

. Azure Active Directory
G Monitor
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@ security Center

© cost Management + Billing

a4 Help + support
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4. From the Virtual Machines page, select the Virtual Machine and click Start.

FIGURE 68 Starting the Virtual Machine

Microsoft Azure

P Search resources, services, and docs

_

Home > Virtual machines

Create a resource Virtual machines

ARRIS G c.
All services _ o
d eservations dit columns efres ssign tags estar o] T Delete 2= Services
+add Or 1 edit col O Refresh ® Assign tag Q' Restart M stop @ Delet s
FAVORITES
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Subscriptions: All 2 sel Don' ption? Open D y + Subscrip g
Dashboard
All subscriptions ~ | | Al resource groups || antypes ~ || Al iecations | | Alltags
All resources
1 of 22 items selected
Resource groups
u  NAME TYPE STATUS RESOURCE GRO... LOCATION MAINTENANCE... SUBSCRIPTION PUBLICIP ADD...
(] AppServices I ———— I
% Function Apps East Asia S SERALTERES 2
= sQL databases  5-1-upgrade-nodez Virtual machine Stopped (deallocated) tdc-nolan-resource  East Asia - Pay-As-You-Go - A... -
& Azure Cosmos DB & | auto-bdc-srvr-1 Virtual machine (cla.. Running auto-bdc-srvr-1 East Asia - Pay-As-You-Go - R... Mot supported
M virtual machines & | auto-bdc-srvr-2 Virtual machine (cla.. Running auto-bdc-srvr-2 East Asia - Pay-As-You-Go - R... Mot supported
& Load balancers & | bill-simpc-01 Virtual machine (cla.. Stopped (deallocated) bill-simpc-01 East Asia - Pay-As-You-Go - R... Mot supported
|| e & | bill-simpe-02 Virtual machine (cla...  Stopped (deallocated) bill-simpc-02 East Asia - Pay-As-You-Go - R... Not supported
R RS S &| bill-simpc-03 Virtual machine (cla.. Stopped (deallocated) bill-simpc-03 East Asia - Pay-As-You-Go - R... Mot supported
@ azure Active ST W riley-simpc-01 Virtual machine Stopped (deallocated) riley-simpc East Asia - Pay-As-You-Go - A.. -
& wonitor Gl riley-simpc-02 Virtual machine Stopped (deallocated) riley-simpc East Asia - Pay-As-You-Go - A... -
@ Advisor g riley-simpc-03 Virtual machine Stopped (deallocated) riley-simpc East Asia - Pay-As-You-Go - A... -
W rity Center @ | scaling-aaa01 Virtual machine (cla.. Running scaling-aaa0l East Asia - Pay-As-You-Go - R... Mot supported
Q Cost Management + Billing W tdc-aaa-server Virtual machine Running riley-vsz-51 East Asia - Pay-As-You-Go - A... 13.70.16.163
;.J e e &| tdc-abe-simpc01l Virtual machine (cla...  Stopped (deallocated) tdc-abe-simpc01 East Asia - Pay-As-You-Go - R... Not supported
[] Images ¥ tdc-abe-simpc0l Virtual machine Stopped (deallocated) tdcaberesourcegroup East Asia - Pay-As-You-Go - R.. -
tdrahauer Virtial marhine Gtanned (daallnratad) trrsharacanrcanrann Fast Ada - Dav-AsVan-Gin-R -
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5. Verify the details and click OK. The new Virtual Machine is created and listed in the Virtual Machine page as shown in the
following image.

FIGURE 69 Virtual Machines

£ Search resources, services, and docs x O > |8 0 0 K
H » Virtual m:
Create a resource Virtual machines
Rud Inc.
All services + dit columns  €) Refresh ® fsigniags P S LB i = Service
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App Services x
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SQL databases &| auto-bdec-srvr-2 Virtual machine (classic) auto-bdc-srvr-2 East Asia Pay-As-You-Go
P @] bill-simpc-01 Virtual machine (classic) bill-simpc-01 East Asia Pay-As-You-Go
&) bill-simpe-02 Virtual machine (classic) bill-simpc-02 East Asia Pay-As-You-Go
Virtual machines
] bill-simpc-03 Virtual machine (classic) bill-simpc-03 East Asia Pay-As-You-Go
m b A Nolans0beta2upgrade Virtual machine Nolan_5.0_betal East Asia Pay-As-You-Go
Storage accounts A NolanS0beta2upgradeNode2 Virtual machine Nolan_5.0_betal East Asia Pay-As-You-Go
i @] scaling-2aa0l Virtual machine (classic) scaling-asa0l East Asia Pay-As-You-Go
Virtual networks
%] tdc-abe-grafana Virtual machine (classic) tdc-abe-grafana East Asiz Pay-As-You-Go
Azure Active Directory ) -
] tdc-abe-simpc01 Virtual machine (classic) tdc-abe-simpc01 East Asia Pay-As-You-Go
Monitor W tdc-abe-simpc01 Virtual machine tdcaberesourcegroup East Asiz Pay-As-You-Go
Advisor A tdcabevs: Virtual machine tdcaberesourcegroup  East Asia Pay-As-You-Go
&) vsz-auto-bdc-1 Virtual machine (classic) vsz-auto-bdc-1 East Asia Pay-As-You-Go
Security Center
@] vsz-auto-bdc-3 Virtual machine (classic) vsz-auto-bde-3 East Asia Pay-As-You-Go
Cost Management + Billing @] vsz-server01 Virtual machine (classic) vsz-server01 East Asia Pay-As-You-Go

Help + support

Network security groups

Images
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6. Select the Virtual Machine, and get the Public IP address as shown in the following image.

FIGURE 70 Public IP Address

Create a resource Virtual machines « # X [ Nolan50beta2upgrade
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SQL databases & Networking “
&) bill-simpe-02 _
Azure Cosmos DB & Disks
NS @] bill-simpc-03 [ 7oays |
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Virtual machines [ NolanSObetaZupgrade
O Security
N — A NolanS0beta2upgradeNode2 CPU (average) » Network (total) »
. .
%] scaling-aaa0l Extensions
torage accounts 100 e
@] tdc-abe-grafana 4 Continuous delivery (Preview)
Virtual networks &) tdc-abe-simpc0l Availability set .
per AR A tdc-abe-simpc0l & Confiuaton 40
A tdcabevsz 205
o | Properties L e et serm e
&) vsz-auto-bde-1 °
Advisor 5 A lods . e - 4o memew e
vsz-auto-bde-3 PERCENTAGECPU © NETWORKIN @ NETWORK OUT @
Security Center @) wsz-server01 E1 Automation script 13.08 % 14.55 kB 12.03 kB
Cost Management + Billing OPERATIONS
Disk bytes (total) » Disk operations/sec (average) >
Help + support D Auto-shutdown

& eac
Network security groups ackup
@ Disaster recovery
Images

Bl Update management >

7. From the Linux PC or terminal use the Public IP address to run the ssh connection as shown in the following image.

FIGURE 71 SSH Connection

can be established.
GwipZq+FALSUIEn svRR s 1dLyE
T3tefea:akcss 1
B5nolT yes
D54 o the list of known hosts e

re Command Lire Interface
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Introduction

You can install vSZ on the Google Computing Engine using the steps mentioned in this section.

NOTE

The minimum memory and CPU requirements have changed in this release. You may need to upgrade your
infrastructure before upgrading. Please read carefully. This is the minimum requirement recommended. Refer to the
tables in GUID-4800DFDE-7381-4785-8D04-EB6D5EA2590B in the Installation Preparation chapter.

Logging into GCE and Selecting a Project

This section describes how to log into the GCE and select a project.
Ensure that you have created an account with GCE and have the login details for the same.

1. Click http://cloud.google.com to access the Google Cloud Platform website.
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2. Login using your user name and password.

FIGURE 72 Login with user credentials

Google

One account. All of Google.

Sign in to continue to Google Cloud Platform

sc200test

Meed help?

Create account

3. Select My console as shown.

FIGURE 73 GCE Page - My console

) Google Cloud Platform Searen st
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4. Alist of projects you created is displayed. Click to choose a project.

FIGURE 74 Choose the project

§§ 9 uptors frentrinl and youl gat §200 in credit and 60 days to explose Googla Cloud Platform. Lesrn more DISMISS SIGN UP FOR FREE TRIAL

ﬁ Home Dashboard GCE-Test jlosryessenoeddy
$0A31-2 2qe3-1-2
51 Dashboard  TOCST
Project: TOC-ST
= Atviy Manage il progcts
10: edoet (FH2846597 5414 Crante o project [ Rp—
Try Compute Engine
af LY ]
Use Google APIs
Enable APls, create credentials, and track

NOTE
You can create projects by clicking Create a project in the drop-down.
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5. Click Product and Services icon to view the list of GCE services.

FIGURE 75 Selecting a Project

Dashboard

Project: TOC-ST

ID: tde-st (F624465975414)

) Google Cloud Platform

4 Home
RPI APl Manager
B=  Billing

A  Cloud Launcher

S  Permissions
COMPUTE
-@- App Engine

{s} Compute Engine
@  Container Engine

Networking

Documentation

Google Cloud Platform document

board

Project: TDC-ST

1D: tdc-at (162446597 5414)

pute Engine

Try App Engine (sandbox
environment)

Create and deploy a Hello World app
without worrying about the underlying
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infrastructure in this ouided walkthrouoh

Documentation
B Google Cloud Platform documen
Bl Cloud Platform solutions (7

B cloud Plstform tutorisls (7

Use Google APls

Enable APls, create credentials,
your usage

API Ensble and manage APls

Try App Engine (managt
environment)
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Creating a Storage Bucket

You can create storage for the objects you create. Follow these steps to create storage.

1. From Google Developers Console, click Product and Services icon > Storage. The Cloud Storage Buckets screen
appears.

FIGURE 76 Storage Bucket Browser

i3

) Google Cloud Platform

@ Bigtable

SQL

«©

=00 Datastore

Storage

2. Click Create Bucket. The New bucket screen appears.

FIGURE 77 Creating a Storage Bucket

= Google Cloud Platform Q

E Storage Browser € CREATE BUCKET (! REFRESH

& Erowser Buckets
: THEREET Nama Storage class
vsz-asia Standard
o Settings
YEZ-UE Standard
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3. Complete the following fields,
a) In Name, type the name of the storage bucket

b) In Storage class, select the storage class you want. You can choose from Standard, Durable Reduced Availability
(DRA) or Cloud Storage Nearline in the drop-down list. Use the below table to compare the storage classes.

¢) InLocation, select the location from the drop-down list.

TABLE 9 Bucket Storage Location

Storage Class Characteristics Use Cases Bucket Location
Standard Storage High availability, low latency Storing data that requires low Continental locations
(time to first byte is typically latency access or data that is
tens of milliseconds). frequently accessed ("hot"

objects), such as serving
website content, interactive
workloads, or gaming and
mobile applications

Durable Reduced Availability Lower availability than Applications that are Continental and regional
(DRA) Standard Storage and lower particularly cost-sensitive, or locations
cost per GB stored. for which some unavailability is

acceptable such as batch jobs
and some types of data

backup.
Cloud Storage Nearline Slightly lower availability and Data you do not expect to Continental locations
slightly higher latency (time to | access frequently (i.e., no more
first byte is typically 2 - 5 than once per month). Typically
seconds) than Standard this is backup data for disaster
Storage but with a lower cost. recovery, or so called "cold"

storage that is archived and
may or may not be needed at
some future time.
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FIGURE 78 New Bucket Information

Create a buckat

MNamsa
The bucket name must be unique across Cloud Sto@ge.

vgz-test

Storage class

Standard -
Location
United States i

Frivacy: Do notinzlude sensitive information in the buzket name. Users cannot
access your data without permission, but they can still try to access or create
buckets to find out if the name axists.

Create Cancel

4. Click Create. The storage bucket you created is listed in the browser.
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5. To create another storage, click Create bucket as shown.

FIGURE 79 Creating Another Storage Bucket

Permissions

APls & auth
Name Storage class

Monitoring . . .
vsZ Durable Reduced Availability
Source Code
Deploy & Manage
Compute
Metworking
Storage

Cloud Bigtable

Cloud Datastore

Cloud SQL

Cloud Storage

Storage browser

age settings

Big Data

6. Verify that the storage bucket has been created.

FIGURE 80 Selecting the Storage Bucket

Browser £ CREATE BUCKET ( REFRESH
Buckets
Namsa Storage class Locatien
vsz-a8ia Standard ASIA-EASTT
vsz-test Standard Us
YEZ-UE Standard US-CEMTRALT
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Uploading the vSZ Image to a Storage Bucket

Follow these steps to upload a controller image to the storage bucket you created.
1. Extract the vSZ raw.bin file that you obtained from Ruckus Networks.
NOTE

* Ifthe"pPermission denied" error appears, execute the command "chmod +x vscg-3.5.0.0.808.raw.bin"
before extracting the file.

* Ifthe "uudecode: command not found"error appears during the extraction process, install the
"sharutils" package, and then try extracting the image again.

Read the Virtual SmartZone (vSZ) Software License agreement that appears when you extract the raw.bin file.

When the Accept this agreement? prompt appears, enter yes to accept the license agreement.

When the extraction process is complete, a raw.tar.gz file appears.

4. Onthe GCE web interface, browse to the storage bucket where you want to upload the vSZ image file.

FIGURE 81 Browse to the storage bucket

Google Cloud Platform TocsT ~ Q
E Storage Browser ¥ UPLOAD FILES E3 CREATE FOLDER C REFRESH
@ Browser

Buckets / vsz-on-goeus
o Transfer

oy Settings There are no objects in this bucket.

5. Click Upload files.
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6. Browse to the location of the .raw.tar.gz image file that you extracted, and then select it.

NOTE
You can only select .raw.tar.gz files.

FIGURE 82 Select the .raw.tar.gz image file that you extracted

= File Upload b
(5] vr s J 0w e

Places Name v | Size Modified

@ search [5] wscg-3.5.0.0.808.raw.bin 954.4 MB 03/26/2017

) Recently Used
root
Desktop
[ File system

Documents
Music
Pictures
Videos
Downloads

All Files | £

Cancel H Open ]

7. Click Open to upload the image file.

Your browser displays the progress of the file upload process. After the upload process is complete, the image file
appears in the storage bucket.

FIGURE 83 The image file appears in the storage bucket

Google Cloud Platform TocsT ~ Q
E Storage Browser ¥ UPLOAD FILES E3 CREATE FOLDER C REFRESH
@  Browser

Buckets [ vsz-on-gce-us f

- Transfer

Name Size T Storage class Last medified
£ Settings e o

[} vscg-3.5.0.0.808.raw.targz 1,009.13MB  application/x-gzip Nearline 4/5/17, 9:19 AN
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Creating a vSZ Image for Virtual Machines

Follow these steps to create a vSZ image for virtual machines.

1. From Google Developers Console, click Compute > Compute Engine.

FIGURE 84 Select Compute Engine

™ Google Cloud Platform

-@®- App Engine

Compute Engine

{=}
@ Container Engine
-

Networking
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2. Onthe menu, click Images, and then cllick Create Image.

FIGURE 85 Click Create Image

EE:IE Compute Engine Images [+] CREATE IMAGE C REFRESH
VWM inst
n fnstances Filter by label or name Columns ~
& Instance groups
<< Previous 1 2 Next >»
[E  Instance templates
Name Size Created by Family
B Disks
@ sql-2016-web-windows-20122-dcv20170214 50 GB Microsoft sql-web-2
[] Snapshots
& P & sql-2016-web-windows-2016-de-v20170227 50 GB Microsoft sql-web-2
[} images @ ubuntu-1204-precisev20170330 10GB  Canonical ubuntu-1;
Ij!  Committed use discounts @ ubuntu-1404-trustyv20170330 1068 Canonical  ubuntu-s
SZ  Metadata @ ubuntu-1604-xenialv20170330 10 GB Canonical ubuntu-1¢

The Create an image page appears.
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3. Configure the properties of the new image by fillng out the boxes below.
a) In Name, type the name of the image.
b) In Description, provide a brief description about the image.

¢) In Encryption, select an option from the drop-down list containing Automatic (recommended) and Customer
supplied.

d) In Source, select Cloud storage file.

e) In Cloud Storage file, click Browse, and then select the .raw.tar.gz image file that you extracted previously.

FIGURE 86 Creating an image

= Google Cloud Platform 70

EIE]E Compute Engine < Create animage
B VMinstances Mame
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& Instance groups
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Cloud Storage file
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named disk. raw.

Zones

B vszongeeus/vscg-3.5.0.0.808 rawtargz Browse

fH
(®  Operations
|=] Quotas
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4. Click Create.The new image is listed.

GCE creates the new image. When the process is complete, the image you created from the .raw.tar.gz image file
appears on the Images page.

FIGURE 87 The new image you created appears on the Images page

Google Cloud Platform TC

{iﬁ Compute Engine Images [+] CREATE IMAGE C REFRESH
VM instances
a name:vsz3-5-0-0-808 Columns ~ Q@ Labels
i  Instance groups
Name Size Created by Family Creation time
@ instance templates @ vsz3-50-0808  40GE  TDC-ST Apr 5,2017, 9:23:31 AM
B Disks
Show deprecated images

Snapshots

[  images

Ii!  committed use discounts

You have completed creating an image.

Creating a Network and Configuring Firewall
Rules

Follow these steps to create a network and configure firewall rules for your network.

1. From Google Developers Console, click Networking > Networks. A page displaying a list of networks appears. Select
the default network.

FIGURE 88 List of networks

= Google Cloud Platform Q

% Networking Networks CREATE NETWORK

= Name ~ Region Subnetworks P addresses ranges Gateways Firewall Rules

5 External IP addresses 4 6
us-centrall default-f088469e3c9d00fa 10.128.0.0/20 10.128.01

B8 Firewall rules europe-west1 default-a2352a305b4819ed 10.132.0.0/20 10.132.01

P R asia-east] default-f178010a%beefb5d 10.140.0.0/20 10.140.0.1

outes

us-east] default-11e13ceee850524d 10.142.0.0/20 10.142.01
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2. To create a firewall rule, click Add a firewall rule.

FIGURE 89 Add a Firewall Rule

Firewall rules

Add firewall rule

Name ~ Source tag / IP range
default-allow-icmp 0.0.0.0/0

default-allow-internal 10.128.0.0/9

default-allow-rdp 0.0.0.0/0

default-allow-ssh 0.0.0.0/0

tdc-vsz 59.124.251.135/32, 59.124.228.54/32
VSZ 0.0.0.0/0
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3. The Create a firewall rule screen appears.
a) In Name, type the name of the rule
b) In Description, provide a brief description about the rule.
¢) In Network, type the network address.
In Source filter, select Allow from any source.
In Source IP ranges, type the range.
f)  In Allowed protocols and ports, type the protocols and ports that will be allowed

g) InTarget tags, specify a tag name. It is recommended that you provide a tag as all network instances with this tag
will adhere to the firewall rule.

FIGURE 90 Creating a Firewall Rule
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& Create a firewall rule

By default, incoming traffic from outside your network is blocked. To allow
incorning traffic, set up a firewall rule Firewall rules regulate only incoming
traffic to an instance When a connection is established with an instance, traffic
is permitted in both directions over that connection. Learn more

Nama

¥az

Des cription | 0o

Source filter
Allow fromn any source (0.0.0.0/0) -

Allowed protocols and ports
tcp:91,443,7443,8022 8443,8090,8099,8100,8111,9080,9443,9446,9996-9999;,,

Targettags -
vsZ|

o

Equivalent REST or command line
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4. Click Create. A page displaying the new firewall rule appears.

FIGURE 91 Adding Firewall Rules

Firewall rules

Add firewall rule JEVEETS

= Name ~
default-allow-icmp
default-allow-internal
default-allow-rdp
default-allow-ssh

tdc-vsz

0.0.0.0/0
10.128.0.0/9
0.0.0.0/0
0.0.0.0/0

59.124.251.135/32, 59.124 228.54/32

cmp Apply to all targets
535; udpi0-65535; icmp Apply to all targets
Apply to all targets

Apply to all targets

7443,8022 8443 8090,8099,8100,8111,9080,9443,9446,9996-9999; udp:161,12223 tdc-vsz

M wvsz

0.0.0.0/0

43,8022,8443,8090,8099,8100,8111,9080,9443 9446,9

-9999; udp:161,12223 vsz

Creating a Virtual Machine Instance

Follow these steps to create a new virtual machine (VM_ instance.

1. From Google Developers Console, click Compute > Compute Engine > VM instances.

The VM instances page appears.

FIGURE 92 The VM instances page

Google Cloud Platform 7o

110

Compute Engine

VM instances

Instance groups

VM instances [} CREATE INSTANCE & IMPORT VM &

Filter by label or name Columns = Q@ Labels
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2. Click Create Instance.

The Create an instance page appears.

FIGURE 93 The Create an instance page

Installing vSZ on the Google Computing Engine
Creating a Virtual Machine Instance

Google Cloud Platform 70

EEIE Compute Engine

B VMinstances

#hy  Instance groups
[l Instance templates
B Disks

Snapshots

i Images

Ijl  committed use discounts
sE Metadata

B Healthchecks
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Name

vsz-test

Zone

us-east1-b -
Machine type

4 vCPUs = 18 GB memory Customize

Boot disk

——  Mew 10 GB standard persistent disk
oy Image
- X . -
Debian GNU/Linux 8 (jessie) Change
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Configure the new VM instance that you are creating by filling out the boxes below.

a)
b)
9
d)

e)

In Name, type the name of the VM instance.
In Zone, select a zone from the drop-down list.

In Machine type, accept or modify the default values for vCPUs and Memory.

Under Boot disk, click Change. The Boot disk page appears. Click Custom images.In Show images from, select
the storage bucket where you uploaded the controller image, and then select the image. Click Select.

In Project access, allow API access as appropriate.

FIGURE 94 Creating a new VM instance

Boot disk

Select an image or snapshot to create a boot disk; or attach an existing disk.

0Simages Application images

Show images from
TDC-5T

cacti-34

Custom images

Created from TDC-ST on Mar 21, 2016, 2:20:19 AM

vsz3-4-0-0-976

Created from TDC-ST on Jul 14, 2016, 7:41:37 AM

v5z3-5-0-0-490

Created from TDC-ST on Jan 3, 2017, 8:27:06 AM

vsz3-5-0-0-704

Created from TDC-ST on Mar 3, 2017, 7:50:46 AM

vsz3-5-0-0-741

Created from TDC-ST on Mar 9, 2017, 1:55:15 AM

vsz3-5-0-0-762

Created from TDC-ST on Mar 15, 2017, %:21:38 AM

vsz3-5-0-0-777

Created from TDC-ST on Mar 19, 2017, 8:03:58 AM

® vysz3-5-0-0-808

Created from TDC-ST on Apr 5, 2017, 9:23:31 AM

Boot disk type
Standard persistent disk

In Firewall, select the options as appropriate.

In Project access, allow API access as appropriate.

Size (GB)
100

Existing disks

In Management, ensure that the tag provided is the same as the one provided while creating a firewall rule. This

ensures port mapping happens correctly.
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FIGURE 95 Management Tab

Management Disks Networking SSH Keys

Description (Opiiona

Labels

Key Value
vsz empty

Installing vSZ on the Google Computing Engine
Creating a Virtual Machine Instance

+ Add label

i) In Disk, select the options as appropriate.

FIGURE 96 VM Disk Configuration

Management Disks Networking SSH Keys

Deletion rule
v/ Delete boot disk when instance is deleted

Encryption

Automatic (recommended)

Additional disks

+ Add item

Less

You will be billed for this instance. Learn more

Equivalent REST or command line

j)  In Networking, select the external options as per the following table.

FIGURE 97 Networking
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Managernent Disks Metworking
Subnetwork
Eitarnal IF

Epherneral

IP forwarding

y]

Less

Access & security

Y¥ou will be billed far this instance. Learn more

Create Cancel

Equivalent REST crecrmmand line

External IP Options

Description

Ephemeral

The VM is assigned a dynamic public IP address

None

The VM instance is not assigned an external IP address

New static IP address

The VM is assigned a static public IP address

In SSH Keys, select the options as appropriate.
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FIGURE 98 SSH Keys

Management Disks Networking SSH Keys

These keys allow access only to this instance, unlike project-wide SSH keys Learn more

Block project-wide SSH keys

When checked, project-wide SSH keys cannot access this instance Learn more

Enter entire key data

-+ Add item
Less
You will be billed for this instance. Learn more
&G Cancel
I) Click Create. The VM instances page appears listing the new VM that is created.
FIGURE 99 The new VM appears on the list of VMs
VM instances [ CREATE INSTANCE = & IMPORT VM C REFRESH SHOW INFO PANEL
® 12 instances could be resized to save you up to an estimated 5190 per month and increase performance. Learn more Dismiss all
= Filte e Columns ~
Name ~ Zone Recommendation Internal IP External IP Connect
@ fresh50-524 asia-eastl-a ® Increase perf. I ' SSH - :
& instance-1 us-centrall-c ' | SSH ~ H

You have completed creating a virtual machine instance.

Ruckus Virtual SmartZone Getting Started Guide
Part Number: 800-71961-001 Rev A

115



116

Ruckus Virtual SmartZone Getting Started Guide
Part Number: 800-71961-001 Rev A



Installing vSZ on Amazon Web Services

© INSTAHING AWS CLL ittt ettt et e ae bbbt e bt s bbb s b e b et et et e b et et e b e st e st e st eneebeeseene
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© DElEliNgG @ VSZ INSTANCE...ccuiitiitiitiitesteet ettt sttt b ettt ettt e et et e st e st e st e bt ebeebeebeebeebesbesbenbenrennen

Installing AWS CLI

Ensure that you have created an account with AWS and have the login details for the same.
1. Install pip by running the command

# curl-O https://bootstrap.pypa.io/get-pip.py
# sudo python27 get-pip.py

Install AWS CLI using pip:# pip install
Test the installation by using the command: # aws help

4. To set up AWS CLI you need to get your access and secret key identifier. Follow the instructions and find your identifier

keys.
5. Use the following command to configure CLI:

# aws configure

AWS Access Key ID [None]: xxx

AWS Secret Access Key [None]: xxx
Default region name [None]: us-west-2
Default output format [None]: json

6. The default region should be the same as the bucket region. Refer to Table for the mapping details. In addition refer to

you can also refer to latest version.

Region Name Region

us-east-1 US East (N. Virginia)
us-west-2 US West (Oregon)
us-west-1 US West (N. California)
eu-west-1 EU (Ireland)
eu-central-1 EU (Frankfurt)
ap-southeast-1 Asia Pacific (Singapore)
ap-northeast-1 Asia Pacific (Tokyo)
ap-southeast-2 Asia Pacific (Sydney)
ap-northeast-2 Asia Pacific (Seoul)
sa-east-1 South America (Sao Paulo)

Ruckus Virtual SmartZone Getting Started Guide
Part Number: 800-71961-001 Rev A

117



Installing vSZ on Amazon Web Services
Creating a VM Import Service Role

Creating a VM Import Service Role

1. Inthe AWS web interface navigate to AWS dashboard > Identity & Access Management.

2. Check your account permission by navigating to Users > select your Username > Permissions. Your account should
have the permission - [AMFullAccess.

FIGURE 100 Account Permission

Dashboard I1AM = Policies 7 lAMFullAccess

* Policy Details

Policy ARN am:aws:iam::aws:policy/ITAMFullAccess
Details Description Provides full access to IAM via the AWS Management Console.
Groups
Policy Document Attached Entities Policy Versions Access Advisor
Roles
| Policies read-only @

- |J

Identity Providers L

Account Settings

Credential Report

Encryption Keys ]

3. Create aJSON file called trust-policy.json using the following commands:

{ "Version":"2012-10-17",
"Statement": [
{
"Sid":""’
"Effect":"Allow",
"Principal™:({ "Service":"vmie.amazonaws.com"
}7
"Action":"sts:AssumeRole",
"Condition": {
"StringEquals": {
"sts:ExternalId":"vmimport"

}

4. Use the following command to create a role. Specify the name as vmimport and give the option VM Import/Export
access.

# aws iam create-role --role-name vmimport --assume-role-policy-document file://trust-policy.json

Ruckus Virtual SmartZone Getting Started Guide
118 Part Number: 800-71961-001 Rev A



5.

Installing vSZ on Amazon Web Services
Installing vSZ on AWS

Create a policy for the service role by creating a JSON file called role-policy.json using the following commands. Replace

the bucket name with the storage bucket name that you created.

{

"Version":"2012-10-17",
"Statement": [

{

"Effect":"Allow",

"Action": [
"s3:ListBucket",
"s3:GetBucketLocation"

] 4

"Resource": [
"arn:aws:s3:::<bucket-name>"

]

"Effect":"Allow",

"Action": [
"s3:GetObject"

]l

"Resource": [
"arn:aws:s3:::<bucket-name>/*"

]

Run the following command to attach the policy to the service role created. # aws iam put-role-policy --role-

name vmimport --policy-name vmimport --policy-document file://role-policy.json

Installing vSZ on AWS

Follow the steps to install vSZ using the AWS web user interface.

Logging into AWS

Follow these steps to login to the AWS site.

1. Click https://aws.amazon.com, to access the Amazon Web Services website.
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2. Login with your user credentials of user name and password.

FIGURE 101 Login with user credentials

Account:

User Name:

Password:

| I have an MFA Token (more info)

Sign In

3. Select My Account > AWS Management Console as shown.

FIGURE 102 AWS management console

_ Npus
="Menu ";"amazon English * MyAccount ~ Sign In to the Console

MY ACCOUNT

Account Settings

Billing & Cost Management

Security Credentials
Introducing Amazon Y2 3

Ruckus Virtual SmartZone Getting Started Guide
120 Part Number: 800-71961-001 Rev A



Installing vSZ on Amazon Web Services
Installing vSZ on AWS

Creating a Storage Bucket

Create storage for the objects you create. Follow these steps to create storage.

1. Navigate to Amazon Web Services > Storage and Content Delivery > S3, click Create Bucket as shown.

FIGURE 103 Create Bucket

W) AWS v  Services v

Amazon Web Services

Compute

. EC2
Virtual Servers in the Cloud

EC2 Container Service
b -

Run and Manage Docker Containers

.r Elastic Beanstalk

Run and Manage Web Apps
G Lambda
Run Code in Response 10 Evenls

Storage & Content Delivery

ey
=

Create Bucket

Services v

Create Bucket Actions v
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2. Type the name of the storage bucket and select a suitable regional endpoint to reduce data latency.
FIGURE 104 Selecting regional endpoint

Create a Bucket - Select a Bucket Name and Region

A bucket is a container for objects stored in Amazon 33. When creating a bucket, you can choose a Region
to optimize for latency, minimize costs, or address regulatory requirements. For more information regarding
bucket naming conventions, please visit the Amazon S3 documentation

Bucket Name:

Region: Oregon .

S5et Up Logging > m Cancel

3. Click Create. The storage bucket you created is listed in the browser.

4. Check the storage bucket has been created.

Uploading vSZ Image to a Storage

Follow these steps to upload a vSZ image to the storage bucket you created.

1. Select the storage bucket to upload the vSZ image.
2. Click Upload as shown.

FIGURE 105 Selecting the Storage

B AWS v  Services v

V=l Create Folder Actions v

3. Browse to the location of the vSZ image and select vSZ image file.
Only images with file-type *.raw or .ova or vmdk can be selected.

4. Click Start Upload to upload the file. The upload process is displayed.
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5. Theimage is listed in the storage bucket after the image is uploaded.

FIGURE 106 vSZ Image Uploaded to Storage Bucket

[F L5 Create Folder  Actions ~ Q, Search by profix None Properties Transfers c

All Buckets [Test_bucket

MName Storage Class Size Last Madified
D vecg-3.4.0.0 230 ova Standard 906 9 MB Mo Horw 09 10020004 GMT+E00 2015
D vseg-3.4.0.0 310.0va Standard 983 3MB Mon Dec 28 10:50017 GMT=800 2015
D vscg-3.4.0.0610.0va Standard 983.2 MB Fri Mar 25 123650 GMT+800 2016
B vaeg-3 4.0 0618 ova Standard 1GB Thui Mar 31 141400 GMT+B00 2016
NOTE

The vSZ image should be in the Bucket, which has Region information. Example: Test_bucket

AWS Service Policy

VM Import uses a role in your AWS account to perform certain operations (for example, downloading disk images from an
Amazon S3 bucket). You must create a role with the name vmimport with the following policy and trusted entities.

1. Install the AWS CLI by following the instructions at http://docs.aws.amazon.com/cli/latest/userguide/installing.html
Enter the following command in the AWS CLI #sudo pip install awscli.
Get the access key for the AWS CLI by following the instructions on the AWS website.

A

Add the access key details to the AWS CLI using the following commands

# aws
configureAWS Access Key ID [None]:
AWS Secret Access Key
[None]: Default region name [None]:
us-west-2Default output format
[None]: json
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5. Create a file named role-policy.json with the following policy:

{
"Version":"2012-10-17",
"Statement": [
{

"Effect":"Allow",

"Action": [

"s3:ListBucket",
"s3:GetBucketLocation"

]l

"Resource": [
"arn:aws:s3:::<disk-image-file-bucket>"

]

}I
{
"Effect":"Allow",

"Action": [
"s3:GetObject"

]l

"Resource": [
"arn:aws:s3:::<disk-image-file-bucket>/*"

]

}I
{

"Effect":"Allow",

"Action": [
"ec2:ModifySnapshotAttribute",
"ec2:CopySnapshot",
"ec2:RegisterImage",
"ec2:Describe*"

]l

"Resource":"*"

6. Replace <disk-image-file-bucket> with the appropriate Amazon S3 bucket where the disk files are stored. Run the
following command to attach the policy to the role created above:

7. Replace <disk-image-file-bucket> with the appropriate Amazon S3 bucket where the disk files are stored. Run the
following command to attach the policy to the role created above aws iam put-role-policy --role-name vmimport --
policy-name vsz34-policy --policy-document file://role-policy.json

Importing the vSZ Image

Follow these steps to import the vSZ image into AWS shared AMI.

1. Create a JSON file called import.json using the following commands. Replace the bucket name with the storage bucket
name that you created. In this example, the vSZ image file name is vscg-3.4.0.0.750.ova.

{

"Description": "Import vSz",
"DiskContainers": [
{
"Description": "vSZ 3.4.0.0.750",
"UserBucket": {
"S3Bucket": "<bucket-name>",

"S3Key": "vscg-3.4.0.0.750.0va"
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2. Run the following command to attach the policy to the role created. # aws ec2 import-image --cli-input-json file://

import.json

3. The system displays the below response.

{

"Status": "active",
"Description": "Import vSz",
"Progress": "2",
"SnapshotDetails": [
{
"UserBucket": {
"S3Bucket": "<bucket-name>",

}I
"DiskImageSize": 0.0
}
]I
"StatusMessage": "pending",
"ImportTaskId": "import-ami-ffgofIwl"

"S3Key":

"vscg-3.4.0.0.750.0va"

4. Check the status of the import vSZ image by running the following command. Ensure to enter the correct import task
identifier.# aws ec2 describe-import-image-tasks --import-task-ids "import-ami-ffgofow1"

5. You will see the following converting status response. Check the status until the converting is complete. The estimated

time for conversion is 30 minutes.

"ImportImageTasks": [
{
"Status": "active",
"Description": "vSZ test",
"Progress": "28",
"SnapshotDetails": [
{

"UserBucket": {

"S3Bucket": "<bucket-name>",
"S3Key": "vscg-3.4.0.0.750.0va"

}I
"DiskImageSize": 964430848.0,

"Format": "VMDK"
}
]I
"StatusMessage": "converting",
"ImportTaskId": "import-ami-ffgofIwl"
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Creating the vSZ Instance

Follow these steps to create a vSZ instance on AWS.

1. From Amazon Web Service, click Compute > EC2.

FIGURE 107 Select EC2

7l AWS v  Services v

Amazon Web Services

Compute
'~] EC2

2. Navigate to Images > AMIs to ensure that the imported Amazon Machine Image (AMI) exists. In this example the AMI
file is import-ami-ffgofow1.

FIGURE 108 Select AMI

ug AWS ~ Services v

EC2 Dashboard

Actions ¥
Events 1
Tags Ownedbyme v () rnt
Reports
Limits Name «  AMI Name -« AMIID - Source =  Owner = Visibility ~ Status
- mport-ami-figofSw1 ams-06d 14506 388876002313 Privale ywailable
Instances mport-ami-igloxOgy ami-3cTTale 38¢ IBBETE002313 Private

Spot Requests
Reserved Instances

Bundie Tasks
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3. Navigate to Network & Security > Security Groups > Create Security Group. Security group acts as a virtual firewall
that controls the traffic for one or more instances.

FIGURE 109 Create Security Group
BF AWS v  Services v

EC2 Dashboard - ) i
Create Security Group Actions v
Events a

Tags Q Filter by tags and attributes or search by keyword
Reports
Limits Name ~ Group ID «  Group Name

=] INSTAN sg-997739fc default
Instances sg-f3064196 all-allowed
Spot Requests sg-f7703e92 launch-wizard-1

Reserved Instances

AMIs
Bundle Tasks il

Volumes

Snapshots
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4. Define the setup group name, description, ports and the firewall rule. The table lists the common service ports. For
more information, see Ports to open for AP-vSZ communication.

Port Number Description

UbP

161 SNMP

12223 ZD AP forward update using FTP (control connection)

TCP

21 ZD AP forward update using FTP (control connection)

22 AP SSH

91 AP forward update using HTTP

443 Allows AP get SSH private key and do AP FW udpate via HTTPs
7443 Public API

8022 SSH for management (mgmt-acl is enabled on 1 nic vSZ)

8080 VSZ setup wizard using the web user interface (User will be redirected to the port 8443)
8443 vSZ web user interface

8090, 8099 WISPr for non-web-proxy user equipment

8100 WISPr for web-proxy user equipment

9998 Tomcat for WISPr (internal WISPr portal uses the port 9998)
9080, 9443 Northbound API (NBI)

16384-65000 ZD AP forward update using FTP (data connection)

FIGURE 110 Define Security Group

Create Security Group X

Security group name (|

Description (i
VPC (i vpc-6c680a09 (172.31.0.0/16) * -
* denotes default VPC
Security group rules:
Inbound Outbound
Type i Protocol (| Port Range (i Source (|

Add Rule
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5. Navigate to Instances and click on Launch Instances. Follow these steps.

a) Launch Instance

FIGURE 111 Launch instances

Services v

EC2 Dashboard - Actions v

Events 1

Tags QQ Filter by tags and attributes or search by keyw

Reports

Limits Name -~ Instance D -~ Instance Type -
- i-40312be2 2 micro

-988a913a m4 xlarge
Spot Requests

Reserved Instances

b) Navigate to My AMlIs and choose the Amazon Machine Image (AMI) that you imported previously.

FIGURE 112 Choose the imported AMI

1. Chooss AMI

' : Cancel and Exit
Step 1: Choose an Amazon Machine Image (AMI)
An AM! Is a template that contains the software configuration (operating system, application server, and appiications) required fo launch your instance. You can select an AMI provided by AWS, our user communtty, or the AWS Marketplace; or
You £an select ong of your own AMis

Quick Start 1101of 1 AMis

\ Seach my AMs
ANS Markepiace A | Import-ami-fgfox0gy - ami-3ef7d3 m

ANS WMimport senice: Linwx - CentOS relaase 6.3 (Final) - 26 32.504 23 4 o6 x86 64

Community AMIs N — Gabi

Wrluakzabon hype W,

c¢) Click Next.

d) Choose a suitable instance type. In this example the instance type is m4.xlarge. Based on the number of APs and
client counts, select the instance type to fit the recommended system resources.

The minimum memory and CPU requirements have changed in this release. You may need to upgrade your
infrastructure before upgrading. Please read carefully. This is the minimum requirement recommended. Refer to
Table 5 and Table 6 in the chapter Preparing to Install the vSZ.
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FIGURE 113 Choose the instance type

Step 2: Choose an Instance Type
Amazeon EC2 provides a wide selection of instance types optimized to fit different use cases. Instances are virtual servers that ca
give you the flexibility to choose the appropriate mix of resources for your applications. Learn more about instance types and ho|

Fiter by:  All instance types ~ Current generation ~ Show/Hide Columns

Currently selected: md.xlarge (13 ECUs, 4 vCPUs, 2.4 GHz, Intel Xeon E5-2676v3, 16 GIB memory, EBS only)

Family v Type b vCPUs i v Memory (GiB) -
General purpose 1 1
General purpose 1 2
General purpose 2 4
General purpose t2.large 2 8
General purpose md.large 2 8
a General purpose md xlarge 4 16

e) Click Next.
f)  Select the required network, subnet, and private IP address.

The private IP address cannot be changed once the vSZ image is launched.

FIGURE 114 Configure the instance

Step 3: Configure Instance Details
Configure the instance to suit your requirements. You can launch multiple instances from the same AMI, request Spot Instances to take ady

Number of instances 1
Purchasing option [ Request Spol Instances
Network (i vpe-6c68da0a (172.31.0.0/16) (default) = |C Create new VPC
Subnet (j No preference (default subnet in any Availability Zon: ~ Create new subnat
Auto-assign Public IP  (j Use subnet setting (Enable) -
Placement group (j No placement group -
IAMrole (3 None » C Create new |AM role

g) Click Next.
h) Change the size of storage as required.
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FIGURE 115 Change the storage size

Step 4: Add Storage

Your instance will be launched with the following storage device settings. You can attacl
edit the settings of the root volume. You can also attach additional EBS volumes after I
storage options in Amazon EC2.

Type i Device i Snapshot i Size (GiB) i
Root /dev/sdat snap-817e261c 100
i)  Click Next.

j)  Specify the vSZ instance by giving it a name.

FIGURE 116 Specify the vSZ instance
Step 5: Tag Instance

A tag consists of a case-sensitive key-value pair. For example, you could define a tag with key = Name and value = Webserver. Learn more abo

Key (127 characters maximurn) Value I’\‘}czss characters maximurn)

k) Click Next.
I) Create a new security group or select an existing group. Configure the rules if required.

FIGURE 117 Specify the security group
Step 6: Configure Security Group

& security group is a set of firewall fes that control the traffic for your instance. On this page. you can add rules to allow spacific traffic to reach your instance. For axample, if you want to set up a wab server and allow Inte
your instance, aded rules that allew Lastricted access to the HTTP and HTTPS ports. You can create a new security group of select from an existing one below. Learn more about Amazen EG2 security groups.

|As!lgn a security group: @ Create a new security group |

Select an existing security group

Security group name: launch-wizard-1

Description: leunch-wizard-1 created 2015-09-14T11:39:49.903+068:00

Type (i Protocol (i Port Range (i Source i
S5H - ce 22 Anywhere ~ 0.0.0.0/0
m) Click Next.

n) Review the configuration settings.
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FIGURE 118 Review the configuration settings

Step 7: Review Instance Launch
~ AMI Details Edit AMI
Impaort-ami. ami-3cf7Td3c
0 AWS VMImpor nux - ContOS reloase 6 3 (Final) - 26 32-504 23 4 ol xB0_64
Root Deviea Typ ahcabon b tum
~ Instance Type Edit instance type
Instance Type ECUs vCPUs Memory (GIB) Instance Storage (GB) EBS-Optimized Avallable Natwork Performance
md xlarge 13 4 16 EBS only Yes High
~ Security Groups Edit security groups
Security group name launch-wizard-1
Description launch-wizard-1 created 2015-09-14T11:39:49.903+08:00
Type (i Protocol (i Port Range | Source (i
SSH TP 2 00.000
¥ Instance Details Edit instance details
» Storage Edit storage _
Cancel  Previous [FTTE

o) Click Launch

p) Select the Proceed without a key pair for vSZ instance.

FIGURE 119 Select existing key pair

Select an existing key pair or create a new key pair X

A key pair consists of a public key that AWS stores, and a private key file that you store. Together,
they allow you to connect to your instance securely. For Windows AMIs, the private key file is required
fo obtain the password used to log into your instance. For Linux AMIs, the private key file allows you to
securely SSH into your instance.

Mote: The selected key pair will be added to the set of keys authorized for this instance. Learn more
about removing existing key pairs from a public AMI.

Proceed without a key pair v
Choose an existing key pair
Create a new key pair

Proceed without a key pair

Cancel

q) Verify that the vSZ instance is running. Connect the vSZ instance with the selected key pair using the SSH interface.
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Configuring AWS for a vSZ Instance

Follow these steps to configure AWS for creating and launching a vSZ instance.

Attach a New Disk Volume

Follow these steps to add a new disk volume.

1. Navigate to EC2 Dashboard > Elastic Block Store > Volumes and click Create Volume as shown.

FIGURE 120 Create Volume

EC2 Dashboard - Create Volume Actions v
4

Events
Tags Q, Filter by tags and attributes or search by keyword
Reporis
Limits Name = VolumelD ~ Size -
— INSTANCES vol-33ac5ecc 100 GiB
Instances vol-e718e22e 100 GiB
I Spot Requests vol-faa14805 100 GiB
Reserved Instances vol-fodd2b32 100 GiB
- vol-beD3ec41 100 GiB
AMIs vol-c6laed939 100 GiB
Bundle Tasks = vol-b6d73449 100 GiB
=) ELASTIC BLOCK STORE vol-43ebebb> 10 GiB
| Volumes
Snapshots
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2. Enter the required disk type, size and availability zone.

FIGURE 121 Create Volume

Create Volume X
Type (i General Purpose (SSD) v
Size (GIB) (i 100 (Min: 1 GiB, Max: 16384 GiB)
IOPS (j 300 / 3000 (Baseline of 3 I0PS per GIB)
Availability Zone (j ap-northeast-1a =
SnapshotID (j Search (case-insensitive)
Encryption (| "] Encrypt this volume

Click Create.

Right click on the newly created disk and select Attach Volume. Enter the instance identifier and the desired device
name.

FIGURE 122 Attach Volume

Attach Volume X
Volume [j vol-c2cali 36 in ap-nontheast-1a
Instance (| Search instance ID or Mame tag in ap-northeast-1a
Device (j

5. Click Attach.

Ruckus Virtual SmartZone Getting Started Guide
134 Part Number: 800-71961-001 Rev A



Installing vSZ on Amazon Web Services
Configuring AWS for a vSZ Instance

Allocate a Public IP Address

Follow these steps to allocate a public IP address.

1. Navigate to EC2 Dashboard > Network & Security > Elastic IPs. Click Allocate New Address as shown.
FIGURE 123 Allocate New IP Address

EC2 Dashboard S Allocate New Address Actions v
4

Events

Tags Q Filter by attributes or search by keyword
Reports
Limits
=] INSTANCES
Instances

Spot Requests
Reserved Instances

=] IMAGES
AMis
Bundle Tasks

m

=] ELASTIC BLOCK STORE
Volumes
Snapshots

=] NETWORK & SECURITY
uri ups
| Elastic IPs

2. Click Create.
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3. Right click on the newly created IP address and select Associate Address. Enter the instance identifier or network
interface and the desired device name.

FIGURE 124 Associate Address

Associate Address b 4

Selecl the instance DR network nberface 1o whic h you wish 10 2550¢ e this IP address (54178 178.185)

Instance
Or
Network Interface
Private [P Address Selec Inslance of interface gl ]
REas08 tian }

Warning

I you asociabe an Elastic 1P a00ress wilh your nStance, your cument pubic 1P address S released. Leam mone about |

4. Click Associate.

Change Security Group

Follow these steps to change the security group.

1. Navigate to Instances and right click the target instance.

2. Select Network > Change Security Group.
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3. Select the security groups.

FIGURE 125 Allocate New IP Address

Change Security Groups

Instance I0: HeefBScc

Intertace ID: eni-14ce6ebd

Select Security Group(s) to associate with your instance

Installing vSZ on Amazon Web Services
Deleting a vSZ Instance

Security Group ID Hame Description
o 50-T3064r9%6 all-akowed Al aliowed
2 Sg-9aT T35 default defaull VPC security group

g7 T03e00

sg-efafibid

4. Click Assign Security Groups.

Deleting a vSZ Instance

Follow these steps to delete a vSZ instance on AWS.

Lauins h-wizard-1

Private network

Laund h-wizard-1 created 201 5-09-10T17F. 5406 000800

Privale network

o Y

1. Navigate to Instances and right click to select the vSZ instance that you want to delete.
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2. Select Instance State > Terminate.

FIGURE 126 Select terminate

Launch More Like This
nstance State

Instance Settings

Image

Networking Terminate
CloudWatch Monitoring
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3. Confirm deletion of the vSZ instance by clicking on Yes, Terminate. The vSZ instance is deleted from AWS.

FIGURE 127 Confirm termination of vSZ instance

Terminate Instances X

A Waming
On an EBS-backed instance, the default action is for the root EBS volume to be deleted when the
instance Is terminated. Storage on any local drives will be last.

Are you sure you want 1o terminate these instances?
i-0fabGbab (vsz-3.4-310)
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Configuring the Virtual Machine Interfaces

The vSZ comes with the option to operate with either one (1) network interface or three (3) network interfaces. Therefore the
procedure for setting up the vSZ interface depends on the number of interfaces that it has.

Follow the procedure below that corresponds to the number of interfaces that the vSZ you are installing has:
e Setting Up the vSZ with One Interface on page 141
e Setting Up the vSZ with Three Interfaces on page 153
NOTE
By default, the VMWare ESXi package comes with three network interfaces. If you want to deploy the vSZ with only one
interface, you can edit the virtual machine settings to remove the extra interfaces. The KVM package, on the other hand,

comes with a single interface. If you want to deploy the vSZ with three interfaces, edit the virtual machine settings to
create two additional interfaces.

Setting Up the vSZ with One Interface

Follow these steps to set up the vSZ with a single network interface

1. Log on to the console using; User name: admin Password: admin

2. Atthe vSZ> prompt, enter en to enable privileged mode.
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3. Atthe Password prompt, enter admin. The vSZ# prompt appears.

FIGURE 128 At the vSZ> prompt, enter setup

vhigidigidiidibinifidifinifinidigiziinifinibinifinidigisidis
i Helcome to w32

UEEEIR R RS Ris i Fiis s s piihEisiiEyisd
SZ login: admin

Password:

Please wait. CLI initializing...

b - - E

4. Enter setup. The console displays the current network settings (if any), and then displays the following prompt: Do you
want to setup network? [YES/no]

5. Enter YES. The next screen prompts you to select the profile configuration that you want to use for this instance of vSZ.
The options include: (1) High-Scale (2) Essentials
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6. Enter the number that corresponds to the profile configuration that you want to deploy.

If you selected Essentials and the virtual machine has insufficient memory resources available (for example, the VM has
only 8GB of RAM when the minimum RAM requirement is 12GB), you will be unable to continue with the setup process.

FIGURE 129 Enter the number that corresponds to the profile that you want to deploy

Flease wait. CLI initializing...

Password: ===

ERSE RS E R gy

btart w32 setup process:
pRididiisidin fididiidibinifiifidid binidinig i3 bidiinignisifiditidinisitdifinigigid

b JoE- JoE ob JoE- B E Jeb IE b E IoE o E E S -JoE E-BEE-BE B BEIE B EIE B EBE-BEEBE B EIE B EIE S EBE-BEEBE B
52 Profile
b b 3o Job b b I JeE eE b b eE NE I EE E I EBE BE I EBE BEIEEBEBE I EBE BEIEEBE BE B EBEBEBEBEE NI
1. Essentials
High Scale
Enter "i" for more information.
b JoE- JoE ob JoE- B E Jeb IE b E IoE o E E S -JoE E-BEE-BE B BEIE B EIE B EBE-BEEBE B EIE B EIE S EBE-BEEBE B
Belect Vw32 Profile (1-2): 2
ARNING?! You cannot change the wi5Z pruflle once you complete setup. Are you sure
you want to install the "High Scale” profile? (yrsn)I¥1 _ G
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Enter Y for confirmation. At the IP Version Support prompt, enter one of the following options: 1: IPv4 Only 2: IPv4

and IPve6.

FIGURE 130 Configure the IP address settings of the single interface

pRiidiidibinifidifinidiidiinihin pigisigiaiiniin finisigidiinifinifinisiginiginfinifis
Start v3Z setup process:
UEIEIRIE R R iE iR iE iR BB it B R iEERiE R i R RN

Sof-JuE Jof- - Jub SeE-JeE E E 3o E I -E B -SEBE 6 -SE I -SE-E E-BE JE BEE-BEBE-I6EBEBESE E S BE E-BE BE-E BE BE-BEIEBE-NESE B
52 Profile
3ef-JaE- b 3o Juf- b JaE Jef e 3 JeE Jaf JeE e 3af JeE e SeE Je 3 JeE Jef E JeE 3ef 3eE 3 e 3e eE e 3eE 3o 3 JeE 3 3eE JeE 3 JeE b BeE JeE SefeE 3
Essentials
High Scale

"i" for more information.
oE-E BE 3E b JoE-Tof B S BEBE BE-SEE S B BE B BE-BESESEE S BB BEBE-BE-SE SEE-E B BEBE BESE-BEBESE BB

LCelect v3Z Profile (1-2): £

ARNING?! You cannot change the v3Z profile once you complete setup. Are you sure
you want to install the "High Scale" profile? (ysn)I¥]1 y

etwork iz not setup.

3o JoE- 3o 0E- Job JoE-JoE- o b JE IoE o 0E JoE oE-JoE I BE Jof IoE-Job JoE B b JoE o BE 36 3oE JoE E BEJE BE-JoEoE 3o o JoE IoEE 36 E JEBE N
IP Uersion Support
J0E-J0E b 3o ek b b o 0E B o3 € -BE-3EE BE b -E-BE BE-BE B -E IEBE B -BEIEBE-PE-BEIE-IE-BE-PEIEIE BE-BE-BEBEBE-BE I
1. IPv4 only
IPv4 and IPvb
3o JoE- 3o 0E- Job JoE-JoE- o b JE IoE o 0E JoE oE-JoE I BE Jof IoE-Job JoE B b JoE o BE 36 3oE JoE E BEJE BE-JoEoE 3o o JoE IoEE 36 E JEBE N

belect address type: (1-2)
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8. The IPv4 address setup for Control, Cluster, Management option appears. At the Select IP configuration prompt,
enter 1 for Manual and 2 for DHCP.

FIGURE 131 Configure the IP version setup

3ok Jof-3aE- oE o b JE SoE b SE b JE S JeE JE -E-JE SE-JaE E S b 3E S JE SE -BE b SE e SE S BE JE E-JE E -BE 36 SE o E BEBEE-BE
1. Essentials
High Scale
Enter "i"” for more information.
3ok J0E-oE- o - € IoE I I JE -PE -E E E E -BEBE-IE-E-EBE I -IEBE-NE BEBEBEBE-BE-BEBESE-BE-BEBE-IEBE-PEBEIEIE BE BB
belect vw3Z Profile (1-2): 2
ARNING?! You cannot change the w3Z profile once you complete setup. Are you sure
you want to install the "High Scale" profile? (yrsmlL¥1 y
etwork is not setup.

3o 3o JaE- 0 - 3o 3o JoE- JoE- 0 3o JoE JoE- E- 0E- o Jo JoE- E- BE-0E o JoE JoE- 0E- E-Jof JoE JoE- JoE- 0E- - Jof JoE JoE- JoE- BE- - JoE T IoE- E-DE-EE

IP Uersion Support

o Jof- JoE- 20 o o 3o o JeE- S0 o o o o JeE- S0 o o 3o JoE--JeE- o 0 3o 3o o JeE- S0F- 0E- o 3o Jof- oE- 0E o JoE JoE- oE- E- 0 JoE JoE JoE- E- ENEE

1. IPv4 only
IPv4 and IPvG

ok k- SaE- o o e e o o BE S SoE JoE oE 0E S I JoESeE b S e oE b SeE- eE o eE eE e o oE BE S SeE-SE E BE S 3E E E 0

Gelect address type: (1-2) 1

306 JoE- 3 BE I 6 0E -FE W BEIE N IE-BEBEBE-FEWE-DENEBEIE B IE-BEBEBE DB -FE N IEBEDEBE-BEBEBE-BEE-FE B BE BB
IPv4 address setup for Control.Cluster,Management
3ok 3o o oE- o b JeE IoE b JoE b 6 JoE I JeE JE-BE JeE IoE-JE E I 6 IoE I JoE E-BEJE -IE - IE I BEIE BE-E BE-BEE -E - BE BB EBE
1. Manual
DHCP
3ok J0E-3oE- o - J0E b I I JE -PE b E E E -BE BEIE-E-EBE B IEBE-BE BEBEBE BE-BE-BEBEBE-BE-BEBE-IEBE-PEBEIEBE E BB

belect IP configuration: (1.2)

9. Atthe Primary DNS Server prompt, enter the primary DNS server on the network.

10. At the Secondary DNS Server prompt, enter the secondary DNS server (if any) on the network.
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11.

Enter y to apply settings.

FIGURE 132 Apply Settings

ok e o BB I PE B EIE E BEE I E-eE E 3o eE b BB 6 BB EBE - E-TEE-BE - E-BE BE BB

IP Version Support Settings:

ok - o o o I o PE B I I N I JoE e I e eE e o o o S e RE I IS PE I E

IP Version Support : IPvd only

Interface IPv4 zettings:
o SoE E BE SE 3 JE S o B S BEBEBE BESESESE S-S BB BEBE BESESESESESESE E E S0 J0E S -E -SE-SE-SE-SESE SESE N N

ontrol,Cluster,Management :

3ok J0E-oE- o - € IoE I I JE -PE -E E E E -BEBE-IE-E-EBE I -IEBE-NE BEBEBEBE-BE-BEBESE-BE-BEBE-IEBE-PEBEIEIE BE BB

IF Type : DHCP

IP Address : 192.168.368.136
255.255.255.8
192.168.38.1

3ok J0E-3oE- o - J0E b I I JE -PE b E E E -BE BEIE-E-EBE B IEBE-BE BEBEBE BE-BE-BEBEBE-BE-BEBE-IEBE-PEBEIEBE E BB
DNS Server : 8.8.8.8

Secondary DNS Server @ §.8.4.4

3ok Jof-3aE- oE o b JE SoE b SE b JE S JeE JE -E-JE SE-JaE E S b 3E S JE SE -BE b SE e SE S BE JE E-JE E -BE 36 SE o E BEBEE-BE

Enter 'y’ to apply, 'n’ to modify

Do you want to apply the =settings? (yrsn) y

I'lease wait while sytem configures the network.

It may take a few minutes. ..
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12. To accept settings entery. Else, enter n

FIGURE 133 Accept Settings

ek 3oE- 30 3o JoE- JuE 3o Job- 0E- 3o 3oE-Jof- o E- Jef JoE oEJoE 3o 3 JoE I BE 366 BE-JE JoE B JoE IoE-E oE 3 3o JoE E-BE3E IE-JoEBE b JoE-BEEIEBE
urrent Hetwork Settings (After Applying)

o o Jo- E- 3o JoE JeE- b JoE- 3o JeE- b b b b b B BE B EBE € -E-BEBEBE - -BE-SEBE-PE-BE-IE IE-PE-BEIE-IE-BE-PEIEIE-BE BB
JuE- 3o o b JeE B JeE- - JeE- Jeb-IoE b 0E Jef I JoE I E JoE -BE EBE I E-IeE S BE b -BE-E SE -BEEE B E IEE-IE BEBEE-BE-EBE BB

IP Uersion Support Settings:

ok 3o 3ok - 3o o o - o o e b o o e - o o e E e e BB o E S oI E PE I IE PE - IE-E B3 EE

IF Uersion Support : IPvd only

Interface IPv4 settings:
o 3o JoE- E- 3o JoE oE- b JoE- 3o JeE- b IoE b 6 BE - BE NE B EBE € -E-BEBE E - -BE-SEBE-PE-BE-IE IE-PE-BEBE-IE-BE-PEIEIE-BEBE BB

ontrol,Cluster,Management :
o 3o o 0E- 3o JoE JoE- b JoE- 3o JeE- b b b b b BE NE B BE € -E-BEBEBE - -BE-EBE-PE-BE-IE IE-PE B IE-IE-BE-BEBEIEBE BB

DHCP

192 .166.38.136
£55.255.255 .4
192 .168.38.1

o 3o o E- 3o JoE JeE- b b 3o JeE- b b b b b B 0E B SEBE € -E-BEBEE - -BE-EE-PE-BE-IE IE-PE-BEIE-IE-BE-PEIEIE-BE BB

DNS Server 3Settings:

o 3o o E- 3o JoE JeE- b JoE- 3o JeE- b b b b b BE 0E B SE BE € -E-BEBEBE - -BE-IEBE-PE-BE-IE IE-PE-BEIE-IE-BE-PEIEIEBE BB

rimary DN3S Server : 8.8.8.8

Fecondary DNS Server @ §.85.4.4

o 3o o E- 3o JoE JeE- b b 3o JeE- b b b b b B 0E B SEBE € -E-BEBEE - -BE-EE-PE-BE-IE IE-PE-BEIE-IE-BE-PEIEIE-BE BB
r ] r ) =

nter 'y’ to accept, "n’ to modify

ccept these =zettings and continue? (y-sn) y_
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13. To setup a network, enter y. Else, enter n.
FIGURE 134 Network Setup

GEEEEE R R R g
btart v3iZ setup process:
HEIRIE R RS R R R R R R R R R R R R Rg
urrent NHetwork Settings
3ok Jof- e -oE o b JE SoE b SE S b JE E JE S -BE-JE SE-JaE E b 3E BE JE JE -BEJE SE e 3E BEBE 3E E-JE BE -BE 36 E - 3E BEBEE-NE
IP Uersion Support Settings:

3o 3o b 0 - o 3o JoE- oE- o 0 3o 3o JoE- E- 0 - o Jo JoE- JoE- BE- 0E o JoE JoE- 0E-E Jof JoE o JoE- 0E- E-Jof JoE JoE- JoE- DE - JoE o JoE- E-BEEBE

IP Uersion Support : IPv4 only

Interface IPv4 settings:
3ok JE-3oE- o € b I JoE JE PE -E E E E -BEBEIE-E-EBEBE-EBEBE BEBEBE NE-BE-BEBEBE-BE-BEBE-IE -BE-PE-BEIEBE BE BB

ontrol,Cluster,Management :
b 3o JoE E b -JE JE -BE PE I E-PE BE NI E-BE-BEBEBE B -3E-BEBEBEBE B -BEIE E-BE P IE-E-EBE B BE B BEBESE BB

IP Type : DHCP

IP Address : 192.168.38.136
255.255.255.8
192.168.38.1

3ok JE-3oE- o € 3oE o JoE JE -PE -BEE E E -BE B IE-E-EBE-BEEBE-BE BEBEBENE-BE-BEBEBE-BE-BEBE-IE -BE-PEBEIEBE BE BB
DNS Serwver Settings:

30 JoE- 3 0E I B E -FE W BEIE N E-BEBEFE-PE B FEWEBEIENEIE-BEBEBE BB -FE N FEBEDEE-BEBEBE B -BEBEIE BB
Primary DNS Server : 8.8.8.8

Becondary DNS Server @ 8.8.4.4

3ok JE-3oE- o € b I JoE JE PE -E E E E -BEBEIE-E-EBEBE-EBEBE BEBEBE NE-BE-BEBEBE-BE-BEBE-IE -BE-PE-BEIEBE BE BB
Do you want to setup network? (yrsml) n_
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14. Choose the option for cluster setup. Enter c to create a new cluster or j to join an existing cluster.
FIGURE 135 Cluster Setup

IP Type : DHCP
IF Address :192.168.38.136
¢ 255.255.255.8
192.168.38.1

3630k IoE-IoE- o E -PE b I IE-JE BE E IEE b BE-IEBEBEBE-BE-BEE-BE BEBE I EBE-EBEBEBE-BE-BE-BEIE BE -BE DI BE BB
DNS Server Settings:

3630k IoE-IoE- o E -PE b I IE-JE BE E IEE b BE-IEBEBEBE-BE-BEE-BE BEBE I EBE-EBEBEBE-BE-BE-BEIE BE -BE DI BE BB
Frimary DHS 3erver : B.6.8.8

Secondary DNS Server @ 8.8.4.4

366 I FE FE -PE B FE IE-PE-BE B IE-PEWE-BE-BEBEFEFE-BEFEFEPE PEBEIEIEPEWEBEBEFEBE B -BEFEIE FE-BEFEIEEBE BB

Do you want to setup network? (ysnd n

(Clreate a new cluster or (JJoin an exist cluster (crjl: c

luster Hame (cluster name can contain letters (a-z, A-Z), numbers (B-9), and da
shes (-)): RBuckus-cluster-1

ontroller Description: wSZ-H-1

3o Ju Jef-JaE Jof- E b e 3uf Jef- Jaf Ief e JeE e Jef JeE 3 JeE 3 3eE JaE b JeE b JeE b eE Je b 3eEef 3eE 3ef e 3b e 3af JeE 3 eE e eE e 3eE JeE e
reatesJoin ! create
D ISCOVERY PROTOCOL: tcp

luster Name ! Buckus-cluster-1

lade ID : Bdf2debd-836d-4654-a496-Ycdlacbdd9?9
DESCRIPTION D Ww3Z-H-1

3o JuE Jef-JuE b E JoE 36 JuE SeE-JeE E NE -BE E-Jb BE-SE BE BE-SE B -SE E-SE E EBE I BE-IeESE E -SEBE -3 SE - BE E-BE B -SE BE-BEBE B

Aire these correct (ysmnl:

15. Enter the following information:
¢ Cluster Name
* Controller Description
* Create/Join cluster
* DISCOVERY PROTOCOL
e Cluster Name
* BladelID
* DESCRIPTION
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16. When the prompt Are these correct? (y/n) appears, enter y to confirm the cluster setup. Enter the controller name of

the blade and enter y to specify if the controller is behind NAT. Else, enter n.

FIGURE 136 Configure Cluster Setup

3o JoE- Job- 0 Jo-JoE- JoE- 0 o o JoE- JoE- Job- JoE oo JeE- 0 o o 3o Jof b o Jo o JoE- 0 o JoE- Jof JeE- o Jo o JoE- S0F- o Jof Jof E- o oo E-

Primary DNS 3Server : 8.8.8.8
Becondary DNS Server @ 8.8.4.4
36 3ob I JE-JE E -E E I E E-E-E-E IE -BE -BE B3 EBE NE-SEBEBEE-PE BB IE-E BE-BE BEBEBEBE BB BEIE-BE BE BB
Do you want to setup network? (yrsmnd n
(Clreate a new cluster or (JJoin an exist cluster (cr/jl: c

luster Mame (cluster name can contain letters (a-z, A-Z2), numbers (B-9), and da
zhes (-)): Ruckus-cluster-1
ontroller Description: w3Z-H-1

b o o E BE-BE BE-BESE-SESE - TEJE JoEJoE JoE oE BB EBEBE-SE BEBESESESEE SEJE ST b BB BEBEBE-BE-BE BEBESE
reatesJoin : create
ID [SCOVERY PROTOCOL: tcp
luster Name ! Buckus-cluster-1
lade ID : BdfZdebd-836d-4654-a496-7cdlacbdd97?9
DESCRIFTION : uSZ-H-1
3 3o 3k 6 3E-0E BE-BE FEBE -BEBE W BE-BE-BE BE-BE B IE B EBE-BEBEBE-BE B BE-BE-BE W BE-BE-BEBEBE B BE B EBE-EBEBE-BE B
Are these correct (ysnl: y
Enter the controller name of the blade ([a-zA-ZB8-9-1): v3Z-H-1

Iz this controller behind NAT? (ysn) n

System UTC Time: ZB18-H5-38 B1:59:18 UTC

TP 3erver ([a-zA-ZB-9.-1): [ntp.ruckuswireless.coml

heck if NTP serwver [ntp.ruckuswireless.com] is reachable. ..
Gystem time after synchronization: Z818-85-38 B1:59:16 UTC
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17. To Convert ZoneDirector APs in factory settings to vSZ APs to vSZ APs automatically, enter y, else enter n.
FIGURE 137 Converting Factory Settings to vSZ Settingsl

shes (-)): RBuckus-cluster-1
ontroller Description: wSZ-H-1

o 3oE-E BE 3E 3E JoE T JoE o BE B BEBE BESESE-SESE-SE BE BB BEBE BESESE-SESESESESEE S J0E - -BE-BE-BE-BE-BEBESEBE NN
create

Ruckus-cluster-1
8df 2debd-836d-4654-a496-7cdlac6ddI?9
DESCRIPTION : w3Z-H-1
306 JoE- 3 BE I 6 0E -FE W BEIE N IE-BEBEBE-FEWE-DENEBEIE B IE-BEBEBE DB -FE N IEBEDEBE-BEBEBE-BEE-FE B BE BB
Are these correct (ysnl: y
Enter the controller name of the blade ([a-zA-2B-9-1): V3Z-H-1
Is this controller behind NAT? (yrsmn) n
Bystem UTC Time: 2818-85-38 B1:59:18 UTC
TP Serwver ([a-zA-ZB-9.-1): I[ntp.ruckuswireless.coml
heck if NTP =erver [ntp.ruckuswireless.coml]l is reachable...
bystem time after synchronization: £H18-85-38 B1:59:16 UTC
onvert ZonelDirector APs in factory settings to w3Z APs automatically (y~sn) I[N]
onvert Zonelirector APz in factory settings to v5Z€ AP= automatically (yrsm) [N]

admin’s password!?

admin password:

admin password again:

the CLI enable command password:

the CLI enable command password again:

18. In Reset admin's password, press <Enter>.
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19. Enter the following information:

*  Enter the admin password
* Enter the admin password again
* Enter the CLI enable command password

* Enter the CLI enable command password again
The password reset confirmation appears and starts setup process.

FIGURE 138 Admin Password Reset

e 3o e b 3oE- 3o oE b b 3o € -IoE IE JE E -PE B -E-IE -BE P E-BE BE NI -E-BE-BEBEBEBEBE-BE-BEBEBE B BEIE IE-BE BB BEBE
reate~Join : create

D ISCOVERY PROTOCOL: tcp

luster Hame : Ruckus-cluster-1

: Bdf2debd-B36d-4654-a496-7cdlacbdd9?9

DESCRIPTION i w3Z-H-1
e 3o 3o b JoE- 3o oE b oE- o 6 -BoE -IE E E -PE - -E-IE -BE PE I E-BE BE NI E-BE-BE B BEEE-BE-SEBEBE B BEIE IE -BE P BEE

fAire these correct (yrsmnl): y

nter the controller name of the blade ([a-zA-ZH-9-1): Ww3Z-H-1
Is this controller behind NAT? (y-n) n
Fystem UTC Time: ZB13-85-38 B1:59:18 UTC

TP Server ([a-zA-ZB-9.-1): [ntp.ruckuswireless.coml

heck if NTP =erver [ntp.ruckuswireless.coml is reachable...

Fystem time after synchronization: £8183-85-38 B1:59:16 UTC

onvert Zonelirector APz in factory settings to viZ APs automatically C(y-smn) [N]
onvert ZonelDirector APs in factory settings to v3Z APs automatically C(y-sn) [N]

admin’s password!?

admin password:

admin password again:

the CLI enable command password:

the CLI enable command password again:

admin’s password done!

conf igurations done. 3tarting setup process after 5 =zeconds...

20. The setup process begins.
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FIGURE 139 Setup Process Begins

onvert Zonelirector APs in factory settings to USZ AP=s automatically (y~-nl) [H]
onvert Zonelirector APz in factory settings to vwiZ APz automatically (yrm) [H]

admin’s password!?

admin password:

admin password again:

the CLI enable command password:

the CLI enable command password again:

admin’s password done!?

configurations done. Starting setup process after 5 seconds...
etcsinit.dssnmpd restart
ew hostname: v3iZ-H-1

hange admin password done!?

B - 3ok T - o I o o I I I I I I o e I JeE e 3o I e I 3 E B S S

heck installation status

30k b 3o JoE- E- o6 T E -EE IE -0 -BEFEE-BE-BEFEBE-BEIEBE-BEIEE BEBEIE-BE-BE-BE-IE-BE-BEBEBE-BE-BEBE BB BE BB NI
ait for cluster config operation start!?

ait for cluster config operation start!?

ait for cluster config operation start!?

ait for cluster config operation start!?
Bootstrapping, Wed May 38 BZ:88:33 UTC 28186

lade Channel Opened, Wed May 38 BZ2:88:36 UTC Z818
[#i# #addiis

You have completed configuring the vSZ interfaces. You are now ready to run the vSZ Setup Wizard. See Using the Setup Wizard
to Install vSZ.

1. Log on to the console using the following credentials: User name: admin Password: admin
2. Atthe vSZ> prompt, enter en to enable privileged mode.

3. Atthe Password prompt, enter admin. The vSZ# prompt appears.
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4. Enter setup. The console displays the current network settings (if any), and then displays the prompt: Do you want to
setup network? [YES/no]

FIGURE 140 At the vSZ> prompt, enter setup

0O =

'y
=
T
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5. Atthe Select IP configuration prompt, enter 1 to set up the control interface manually.

a) Configure the IP address, netmask, and gateway of the control interface, and the press <Enter>. The IP address
configuration that you entered appears.

a) When the message Are these correct? appears, enter y to confirm the IP address configuration.

FIGURE 141 Configure the IP address settings of the control interface

1721732122 - PuTTY o B ]

6. Atthe Select IP configuration prompt, enter 1 to set up the cluster interface manually.

a) Configure the IP address, netmask, and gateway of the cluster interface, and then press <Enter>. The IP address
configuration that you entered appears.

b) When the message Are these correct? appears, enter y to confirm the IP address configuration.
7. Atthe Select IP configuration prompt, enter 1 to set up the management interface manually.

a) Configure the IP address, netmask, and gateway of the management interface, and the press <Enter>. The IP
address configuration that you entered appears.

Take note of the IP address that you assign to the management interface - you will use this IP address to log on to
the vSZ web interface.

b) When the message Are these correct? appears, enter y to confirm the IP address configuration.
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8. When the message Select system default gateway (Control, Cluster, Management)?, enter Control or
Management, depending on your network topology (see
on page 156).

This entry is case-sensitive. Make sure you enter the system default gateway exactly as shown at the prompt.

FIGURE 142 When prompted for the system default gateway, enter either Management or Control (depending on
your network design)

1721732122 - PuTTY =R

ient (Web) !

m

9. When prompted, enter the primary and secondary DNS server IP addresses.
10. Enter restart network.

You have completed configuring the vSZ interfaces. You are now ready to run the vSZ Setup Wizard. See
on page 157.

Depending on your network topology, you may select either the Management or Control interface as the system default gateway.

* If all of the managed APs are located in different locations on the Internet, the vSZ may not know all of the IP subnets of
these APs. In this case, the control interface should be set as the default gateway for the vSZ and you will need to add a
static route to reach the management network.

* If all of the managed APs belong to a single subnet or to multiple subnets on which you can set the route statically, then
you can set the management interface as the default gateway users can set default gateway for the vSZ and set static
routes for the vSZ to reach all of its managed APs.
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Before You Begin

The Setup Wizard helps you perform the initial configuration of the vSZ by presenting the vSZ configuration options in a set of

easy-to-complete screens.

The Setup Wizard will prompt you to select one of the two available profile configurations (High-Scale profile and Essentials
profile). You must select the profile configuration that corresponds to the vSZ license that you purchased. Before you start the

Setup Wizard, make sure you know the profile configuration that you need to select. If you are unsure which profile configuration
you need to select, contact Ruckus Networks Support.

Follow these steps to run and complete the vSZ Setup Wizard:

Start the Setup Wizard and Set the Language

Select the Profile Configuration That Corresponds to Your vSZ License
Configure the Management IP Address Settings

Configure Dual Mode IP Address Settings Using CLI

Configure the Cluster Settings

Set the Administrator Password

Verify the Settings

NOTE

This guide describes the Setup Wizard screens that appear when you select the High-Scale profile configuration. If you

select the Essentials profile configuration, the screens that appear may be slightly different.
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Step 1: Start the Setup Wizard and Set the
Language

1. Start your web browser, and then enter the following in the address bar: https://{management-IP-address}:8443,
where management-IP-address is the address you assigned to the management interface. The vSZ Setup Wizard
appears, displaying the Language page.

FIGURE 143 The Language page

I ruckus™ Setup Wizard - Virtual SmartZone

version: 5.0.0.0.661

Language

Welcome to the Ruckus Virtual SmartZone Setup V/izard. Use this wizard to prepare wireless controller to run your wireless network. To start, select the display language that you want to use on the Web interface.

Language | English v]

Profile

Management IP Address
Cluster Information
Confirmation

Configuration

2. Select your preferred language for the vSZ web interface. Available options include:
* English
* Traditional Chinese
* Simplified Chinese

3. Click Next. The Profile page appears.

Step 2: Select the Profile Configuration That
Corresponds to Your vSZ License

1. Select the profile configuration that corresponds to the vSZ license that you purchased. Available profile configurations
include:

* High Scale

e Essentials
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2. Click Next. The Confirmation message appears. Once you accept the confirmation, the Management IP page appears.

FIGURE 144 Select a profile configuration that matches your vSZ license

I Ruckus™

Setup Wizard - Virtual SmartZone

version: 3.5.0.0.562

Language

Management IP Address

Cluster Information

Administrator

Confirmation

Configuration

Profile

Please select profile configuration.

Profile| High Scale v

High-Scale

The High-Scale operating profile is designed for very large scale netviorks. In this mode, each controller node supports up to 10,000 APs and 100,000 clients, while a cluster can support up to 30,000 APs and
300,000 clients. High-Scale mode supports functions commonly required by service providers, including managed service provider (MSP) and MYNO viorkflovss, as viell as advanced netviork segmentation by
domain and zone (with support for thousands of zones). The High-Scale mode is optimized for netvork access and AP control functions, leaving historical traffic and health stats, reporting, and logging to
external tools-like SmartCell Insight (SCI) or 3rd party tools. Please see the "Getting Started Guide” to determine the recommended system resources to run in High-Scale mode.

Essentials

The Essentials operating profile is designed primarily for enterprise netviorks. In this mode, each controller node supports up to 1,000 APs and 20,000 clients, vihile a cluster can support up to 3,000 APs and
60,000 clients. Essentials mode supports functions commonly required by enterprise, hospitality, education, retail, healthcare, and businesses in many other market types-as vl as small-scale MSPs. The
netviork can be segmented into different zones, viith support for up to 1024 zones. The Essentials mode is optimized to handle the full scope of netvrork management and control functions, including AP control,
short-term reporting, logging, troubleshooting, and traffic and health analysis. For many months or years of historical data, vie recommend SmartCell Insight (SCI). Please see the "Getting Started Guide" to
determine the recommended system resources to run in Essentials mode.
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Step 3: Configure the Management IP Address
Settings

The vSZ comes in either a single network interface or three network interfaces (one interface each for Control (AP), Cluster, and
Management (Web) traffic). The following procedure assumes that the vSZ you are installing uses a single network interface.

If the vSZ that you are installing comes with three network interfaces, you must configure each of the three interfaces to be on
three different subnets. Failure to do so may result in loss of access to the web interface or failure of system functions and
services.

1. InIP Version Support, select one of the following options:
IPv4 Only: Click this option if you want the controller to obtain an IPv4 address from a DHCP server on the network.

IPv4 and IPv6: Click this option if you want the controller to obtain both IPv4 and IPv6 addresses from DHCP and
DHCPv6 servers on the network. Refer to Step 4: Configure Dual Mode IP Address Settings Using CLI for configuring dual
setup using CLI. This is an alternative method for configuring IPv4 and IPv6 manually if the DHCP server is not available
on the network.

FIGURE 145 Select the IP version support

Setup Wizard - Virtual SmartZone

version: 5.0.0.0.661

Language Management IP

Select how you want the Virtual SmartZone to obtain its IPv4 (and IPve, if supported on your network) 1P address settings. To obtain an IP address automatically using DHCP, click “DHCP” for IPv4 or “Auto Configuration” for
Profile 1Pv6. To specify an IP address, click “static” and then type the IP address settings in “IP Address,” “Netmask,” and “Gateway.” An asterisk (*) indicates required information.

IP Version Support @ pvs4 only ' IPv4 and IPvé

H Control{AP)/Cluster/Management(Web) ‘

Cluster Information
1pv4

Administrator ® static © DHCP

192.168.30.188

Netmask * ‘255,255.255.0 |

Configuration Gateway* | 192.168.30.1 |

IP Address *

Confirmation

Default Gateway" | C

.
Primary DNS Server | 8.8.8.8
Scondry s
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2. Configure the IP address settings of the Control (AP/DataPlane) interface.

a) Under the IPv4 section, click Static, and then enter the network settings that you want to assign to the AP/
DataPlane interface, through which client traffic and configuration data are sent and received.

Although it is possible to use DHCP to assign IP address settings to the Control interface automatically, Ruckus
Networks strongly recommends assigning a static IP address to this interface.The following network settings are
required (others are optional):

e |P address
e Netmask
*  Gateway

a) Ifyou clicked IPv4 and IPv6 at the beginning of this procedure, under the IPv6 section, click Auto Configuration if
you want the controller to obtain its IP address from Router Advertisements (RAs) or from a DHCPv6 server on the
network. If you want to manually assign the IPv6 network address, click Static, and then set the values for the
following: IP address (IPv6): Enter an IPv6 address (global only) with a prefix length (for example,
1234::5678:0:C12/123). Link-local addresses are unsupported.Gateway: Enter an IPv6 address (global or link-local)
without a prefix length. Here are examples:

Global address without a prefix length: 1234::5678:0:C12

Link-local address without a prefix length: fe80::5678:0:C12

3. Atthe bottom of the screen, select the interface that you want to set as the default system gateways for IPv4 and IPv6 (if
enabled), and then type the Default Gateway, Primary DNS Server address and Secondary DNS Server Address.

The appropriate interface to use as the default system gateway depends on the topology of your network. See
Important Notes About Selecting the System Default Gateway on page 156 for more information.

Check the network settings that you have configured.

Click the Next to continue. The controller validates and applies the network settings that you have configured. Continue
to Step 5: Configure the Cluster Settings on page 171

Important Notes About Selecting the System Default Gateway

Depending on your network topology, you may select either the Management or Control interface as the system default gateway.

* Ifall of the managed APs are located in different locations on the Internet, the vSZ may not know all of the IP subnets of
these APs. In this case, the control interface should be set as the default gateway for the vSZ and you will need to add a
static route to reach the management network.

* If all of the managed APs belong to a single subnet or to multiple subnets on which you can set the route statically, then
you can set the management interface as the default gateway users can set default gateway for the vSZ and set static
routes for the vSZ to reach all of its managed APs.

Step 4: Configure Dual Mode IP Address Settings
Using CLI

The following are the steps to configure the dual setup using CLI. This is an alternative method of configuring IPv4 and IPv6

manually if the DHCP server is not available on the network.

1. Using CLI execute the setup command: vSZ# setup

2. InvSZ Profile, choose either 1. Essentials or 2. High Scale.
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3. InIP Version Support, choose 2. IPv4 and IPv6.

FIGURE 146 Choose 2. IPv4 and IPv6 to use dual mode IP addresses

uSZit setup

pRunnnEEENERRENNNRBRNNBBARNBBBERRRBBARBHERBBR NN
dtart Vv5Z setup process:
Ry nygnnysuyuenunnn

e s S . E FE S S L F TS S ST ST E LSS EE LTSS S LT E T E S S E E E S B B R R SR
vSZ Profile

W W e e e e e e e e e e e e e e e E e e e e Db e e G e e e E e e e e e DeE W e e e e e e e e
1. Essentials

Z. High Scale

e s s S S ST S LT ET TS ST ST ETLEE ST S LSS S ST ESTES S S E S S B B B E R R N
Select vSZ Profile (1/2): 1

Current network settings:

Network not setup?

e g S s S S . . S S S S .t g d S S R R S S S S & f g g S S F R . g m o n & g g g R R R R ok o
IP Version Support

e . 2 2 3 2 2. £ 2 3 S 3 L & 3 S F X R S S 3 S S . S 3 $ 2. E. R L. L S S 3 X & T L S X R _E_ L % % 3
1. IPv4 only

Z. IPv4 and IPv6

W o W o e W e W W W W e e W W W e W W W e e e W e W W W e e e e W W e W e -

Select address type: (1,/2)
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4. Configure the IPv4 address settings that you want to assign to the AP/DataPlane interface, through which client traffic
and configuration data are sent and received.

a) Enter the setup for Control as either:
1. Manual
2. DHCP
b) Enter the IP configuration as 2 (DHCP).
¢) Enter following network settings as required:
* |P address
*  Netmask
* Default gateway

d) Save the networking configuration of Control settings.
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e)

g
h)

FIGURE 147 IPv4 Control Settings
e o e e e e ke e e e o e e e ke e o e e e o e e e e ke e e e o e e e ke e e e o o e e R e e e o e

IPv4 address setup for Control

AEEEEEAEEEREEEAAEAEAAEEAAAAAERARARAAAREARAAAEREA R AR A RR

1. MANUAL
2. DHCP

o e e e e e e R e e R e e o e e e e o R R e o e e o o R e e o e R o e R R R o o

Select IP configuration (1/2): 2

AEEEEEAEEEREEEAAEAEAAEEAAAAAERARARAAAREARAAAEREA R AR A RR

Control:

IP Address - 182.21.160.66

Netmask $ 255.255.255.240
Gateway 0 182.21.160.65

Are these correct (y/n): y

Execute networking configuration of Control!
Save networking configuration of Control!

AR A AR EE A A A A EA A A AAERARARAAARAEAARAAATREAR AR AR

Enter the setup for Cluster as either: 1. Manual 2. DHCP
Enter the IP configuration as 1 (Manual)
Enter following network settings as required: IP address, Netmask, and Default gateway

Save the networking configuration of Cluster settings.

FIGURE 148 IPv4 Cluster Settings
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e e i e e e e i e e e e e e e e v de o T e e de e e e e dede e e e e de e e de e o de dede de s dede gk

IPv4 address setup for Cluster
1. MANUAL

2. DHCP

Select |IP configuration (1/2): 1
IP Address: 182.21.160.82
Netmask: 255.255.255.240
Gateway: 182.21.160.85

o e T e e T T TR e e e e T e R T o o o e e e e o e e R R R R e R

Cluster:

IP Address 0 182.21.160.82

Netmask 1 2955.255.255.240
Gateway 0 182.21.160.85

Are these correct (y/n): y

Execute networking configuration of Cluster!
Save networking configuration of Cluster!

e A e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e i e e e ke e e e i e e e R ke ke

i) Enter the setup for Management as either: 1. Manual 2. DHCP
j)  Enter the IP configuration as 2 (DHCP)
k) Enter following network settings as required:

IP Address

Netmask

Gateway
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)

Save the networking configuration of Management settings

FIGURE 149 IPv4 Management Settings
FREEREKRERERREERRERR R TR ER R R TokdRkkRhkdhkkiiiihkk

IPv4 address setup for Management

tdE b s A s E LTS LS L EEEEEEELEEEEEEEEEE SR
1. MANUAL

2. DHCP

w i g ek Akl e ke kR de ke ke ke R kR Rk ke ke ek kR kR ke kR ke ke ke ok Rk kek kR ok

Select IP configuration (1/2): 2

e e e e e e e ol ol e e e e e e ol e e e e i e e e e e e il e e e e de e kel ke e kel ke ke

Management:

IP Address 0 172.19.10.2
Netmask :255.255.0.0
Gateway - 172.19.10.254

e e e e e e e e e e e e e i e e e e e e sl e e e e e e e e ol e e e e o e e o sl e e e ol o o o o e

Are these correct (y/n). y

Execute networking configuration of Management!
Save networking configuration of Management!

The available gateway for Control, Cluster and Management will be displayed. You can select the system default

gateway.

FIGURE 150 Default Gateway Settings
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v v ol i o e ol o o ol e ol ol i i ol e ol ol ol ol ol ol il o e ol vl ol ol ol ol il

Available Gateway:

i vl e e vl ol e i e e ol ol oy o vl e ol ol ol o e o e vl sl o ol ol o ol ol e ol vl o o e ol el

Control ©182.21.160.65You
Cluster +182.21.160.85
Management ©172.19.10.254

i i i i o i o i o e o ol ol e o i ol e ol 2 i o o 9l 2l i ofr 9 ol i o o ol ol oo o ol ol o i

Select system default gateway (Control, Cluster, Management)? Control
Primary DNS: 4.2.2.2

Secondary DNS:

Control NAT IP:

5. Ifthe controller is behind a NAT server, add the control NAT server IP address, and then hit Enter.

FIGURE 151 NAT server IP address

Control NAT IP:
Network would be restarted. You could connect to v§Z back by using Management po

rt (16.26.110.6)!!
Enter "restart network” or press Enter to continue... restarrt network

Ruckus Virtual SmartZone Getting Started Guide
Part Number: 800-71961-001 Rev A 167



Using the Setup Wizard to Install vSZ
Step 4. Configure Dual Mode IP Address Settings Using CLI

6. Configure the IPv6 address settings that you want to assign to the AP/Data Plane interface, through which client traffic
and configuration data are sent and received.

NOTE
The cluster interface setting does not support IPv6 addresses.

a) Enter the setup for Control as either: 1. Manual 2. Auto Configuration
b) Enter the IP configuration as 1 (Manual).
c) Enter following network settings as required:
* IPv6 Address
*  Gateway
d) Save the networking configuration of Control settings.

FIGURE 152 IPv6 Control Settings
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k-

IPv6 address setup for Control
1. MANUAL
2. AUTO CONFIGURATION

e e e i e e e e e e e e i e e e e e B e o i e e i e e e i e e e e e o s e kR R kR

Select IP configuration: (1/2) 1

IPv6 Address: 3000:2:1:1::1/64
Gateway: 3000:2:1:1::254

FhEhkkkhhkhkhhkkdhhEdddbhddhhdddhhkddhhbkkhhhhhhhhdhid

Control:

IP Address - 3000:2:1:1::1/64
Gateway - 3000:2:1:1::254

Are these correct (y/n). y

Execute networking configuration of Control!
Save networking configuration of Control!

e) Enter the setup for Management as either: 1. Manual2. Auto Configuration
f)  Enter the IP configuration as 1 (Manual)
g) Enter following network settings as required: IP addressDefault gateway

h) Save the networking configuration of Management settings.

FIGURE 153 IPv6 Management Settings
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IPv6 address setup for Management

e e e e e e e e e e e R e e e o e e ol e e e ol e e e e e R o e o e e ol e e e e e e e e e e

1. MANUAL

2. AUTO CONFIGURATION
Select IP configuration: (1/2) 1
IPv6 Address: 3000:2:1:1::2/64
Gateway: 3000:2:1:1::254

e e e e e e e e e e v e i e e e o e e e o e e ol e e o e e o o e e ol e e e e e o o e e ol e e e o

Management:

IP Address : 3000:2:1:1::2/64

Gateway - 3000:2:1:1::254

Are these correct (y/n). y

Execute networking configuration of Management!
Save networking configuration of Management!

The available gateway for Control and Management will be displayed. You can select the system default gateway.

FIGURE 154 Default Gateway Settings

Available Gateway:

Control S 3000:2:1:1::254

Management S 3000:2:1:1::254

Select system default gateway (Control, Management)? Control

Primary DNS: 3000:2:1:1::254

Secondary DNS:

Network would be restarted. You could connect to SCG back by using Management port (172.19.10.2 or 3000:2:1:1::2)!!
Enter "restart netwark” or press Enter to continue... restart network

7. Enter "restart network".
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8. Go back to the controller's web interface, and then go to System > Cluster > Control Planes. Then, expand the node,
select the Cluster plane, and click Configure.

The Edit Control Plane Network Settings page appears.

FIGURE 155 Control Plane Network Settings

Edit Control Plane Network Settings

This page lists the netwark configuration settings of the selected control plane. You can modify the interface settings, northbound control interface settings, or manually configure the static routes.
Physical Interfaces Static Routes

Control/Cluster/Management Interface

IP Mode: () Static (@) DHCP

Default Gateway & DNS

IPv4 Default Gateway & DNS

" Default Gateway: | Control/Cluster/Manag ¥

Primary DNS Server: | 8.8.8.8

Secondary DNS Server: | 8.8.4.4

« 0K | | % Cancel

9. Verify that the Control Plane network settings display the IPv4 and IPv6 addresses that you configured.
10. Continue to Step 5: Configure the Cluster Settings on page 171

Step 5: Configure the Cluster Settings

The next step is to configure the vSZ cluster settings. The actions that you need to perform in this step depend on whether you
are creating a new cluster (with this vSZ as the first node) or you are setting up this vSZ to join an existing cluster.

e |fThisvSZ Is Forming a New Cluster on page 172
e |f ThisvSZ Is Joining an Existing Cluster on page 172
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FIGURE 156 The Cluster Information page, showing the New Cluster option

Setup Wizard - Virtual SmartZone s Coieet

Language Cluster Information

Profile VSZ Cluster Setting: | New Cluster

Cluster Name: | Ruckus-vsZ-H-Cluster |

ansmant kLA Controller Name: |vsz-+-1 |

Controller Description: |ysZ-H-ySZ-H-1[1

Default Country Code: | United States v
Administrator -
NTP Server: | ntp.ruckuswireless.com |

¥ bEantion AP Conversion [ | Convert ZoneDirector APs in factory settings to Virtual SmartZone APs automatically

Configuration 1) Is this controller behind NAT?

If This vSZ Is Forming a New Cluster

Follow these steps if you want to use this vSZ to create a new cluster.
On the Cluster Information page, configure the following settings:
1. In vSZ Cluster Setting, select New Cluster.

2. In Cluster Name, type a name for the new cluster that you are creating.

NOTE
The Cluster Name and Controller Name boxes only accept alphanumeric characters, hyphens (-), and
underscores (_). They do not accept the space character or other special characters (for example, $, *, #, !).

In Controller Name, type a name for the vSZ controller in this new cluster.
In Controller Description, type a brief description for the vSZ controller.

In Default Country Code, select the country.

o v kMW

In NTP Server, type the address of the NTP server from which members of the cluster will obtain and synchronize time.
The default NTP server isntp.ruckuswireless.com

7. If you want ZoneDirector APs that are in factory default settings to be converted to SmartZone APs automatically, select
the AP Conversion check box.

If the controller is behind NAT, select the check box and enter the Controller NAT IP.

Click Next to continue to the Administrator page.

If This vSZ Is Joining an Existing Cluster

If this is not the first vSZ cluster on the network, you can set up this vSZ virtual appliance to join an existing cluster.

A VSZ cluster supports a maximum of four nodes. If you are building a vSZ-E cluster with more than two nodes, two (2) additional
cores must be added to each node to support the added search and replication capabilities.
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NOTE

To add this vSZ to an existing cluster, the entire target cluster must be in a healthy state (no node must be in “out of
service” state). If any member node is out of service, the join request will fail. You will need to remove any out-of-service
node from the cluster before you can add a new node successfully.

Follow these steps to configure this to join an existing cluster.

N o un ks~ w

In vSZ Cluster Setting, select Join Existing Cluster.
In Cluster Name, type the name of the cluster that this vSZ is joining.

The Cluster Name and Controller Name boxes only accept alphanumeric characters, hyphens (-), and underscores ().
They do not accept the space character or other special characters (for example, $, *, #, ).

In Controller Name (optional), type a name that you want to assign to this new controller.

In Controller Description, type a description for this new controller.

In Join Exist vSZ Cluster IP, type the IP address of the leader in the existing cluster.

In Admin Password, type the administrator password to the web interface of the leader node.

Click Next to continue to the Administrator page. See Step 6: Set the Administrator Password on page 173.

FIGURE 157 The Cluster Information page, showing the Join Existing Cluster option

A rucius™ Setup Wizard - Virtual SmartZone oo 3500789

Language Cluster Information

Profile VSZ Cluster Setting: | Join Existing Cluster v
Cluster Name:

Management IP Address Controller Name:

Controller Description:

Join Exist vSZ Cluster IP:

Administrator
Admin Password:*

Confirmation

Configuration

If the firmware version on this vSZ (shown in the bottom-left area of the Cluster Information page) does not match the
firmware version of the cluster, a message appears and prompts you to upgrade the vSZ firmware. Click Upgrade, and then
follow the prompts to perform the upgrade.

Step 6: Set the Administrator Password

Set the administrator passwords for the web interface and command line interface (CLI).

Follow these steps to set the web interface and CLI passwords.
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NOTE
The web interface and CLI passwords must be at least eight (8) characters in length and must include one number, one
letter, and one special character (for example, $, *, #, ).

1. In Admin Pasword, type a password that you want to use to access the web interface.
In Confirm Password, retype the password above to confirm.

In Enable Password, type a password that you want to use to enable CLI access to the vSZ.

In Confirm Password, retype the password above to confirm.

vk W

Click Next to continue. The Confirmation page appears and displays all the controller settings that you have configured
using the Setup Wizard.

FIGURE 158 Set the web interface and CLI passwords

M rucius™ Setup Wizard - Virtual SmartZone

version: 3.5.0.0.789

Language Administrator

Enter Admin's passv/ord and passviord that permits administrative access to the VWeb interface. (Use this information to log into the Web interface after this setup is complete, to further configure your nevr
Profile viireless netvrork.)

Admin Password *

Management IP Address Confirm Password *

. Enter CLI enable passvord and passvord that provides advance command
Cluster Information
Enable Password *

Confirm Password *

Confirmation

Step 7: Verify the Settings

After you complete setting the web interface and CLI passwords, check the Confirmation page and review all of the controller
settings that you have configured using the Setup Wizard.

Follow these steps to verify the controller settings that you have configured.

1. Verify that all the settings displayed on the Confirmation page are correct.
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2. Ifthey are all correct, click Finish to apply the settings and activate the controller on the network.

FIGURE 159 The Confirmation page

ﬁ Ruckus™ i - i
‘ Setup Wizard - Virtual SmartZone N
Langdose Confirmation
Please review the following settings. If changes need to be made, click Back to edit your settings. If the settings are ready for use, click Finish.
Profile
Profile Type High scale
Management ib Address Cluster Name Ruckus-vSZ-H-Cluster
Protacol Type TP
Management IP Control(AP)/Cluster/Management(V/eb): Manual 192.168.30.188
Cluster Information Default Country Code US

Systam time will be automatically set.
System Time Your current system time is
Administrator (2018-05-31 05:17:27 Epoch : 1527729447 )

* after completing the setup wizard, please check the Ruckus V/ireless Support V/eb site for the latest software updates.

Restore from Config Backup: | Chaose File | No file chosen

Configuration

I

NOTE

If you find an incorrect setting, click the Back button until you reach the related page, and then edit the
settings. When you finish editing the settings, click the Next button until you reach the Confirmation page
again.

A progress bar appears and displays the progress of applying the settings, starting the vSZ services, and activating the
vSZ on the network.

When the process is complete, the progress bar shows the message 100% Done. The page also shows the IP address
through which you can access the vSZ web interface to manage the controller.

FIGURE 160 Setup is complete when the progress bar shows “100% Done”

Setup Wizard - Virtual SmartZone

version: 5.0.0.0.661

Lo ass Configuration
The SmartZone is being canfigured. it may take up ta 20 minutes to complete the setup process. Stretch your legs, grab some coffee, and if you changed the IP address during setup, don’t forget to update the browser’s URL.
Profile
205
Management IP Address Blade Channel Opened 3
Clitar bdomation WARNING Please do not power off, reboot, disconnect, start another installation from a cluster member or change the IP address of any of the cluster members during the setup process. This will cause the initial setup to fail

and you vll have to start the setup process from the beginning.

Administrator

Confirmation

Congratulations! You have completed the Setup Wizard. You are now ready to log on to the web interface. Go to https://
{management-IP-adddress}:8443, and then log on with the user name and password that you assigned to the web interface.
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Logging On to the Web Interface

You can access the web interface from any computer that is on the same subnet as the management (web) interface. Follow
these steps to log on to the vSZ web interface.

1.
2.

On a computer that is on the same subnet as the Management (Web) interface, start a web browser.

In the address bar, enter the IP address that you assigned to the Management (Web) interface and append a colon and
8443 (vSZ management port number) at the end of the address. The vSZ web interface logon page appears.

If the IP address that you assigned to the Management (Web) interface is 10.10.101.1, then you should enter:
https://10.10.101.1:8443
The vSZ logon page appears.

FIGURE 161 The vSZ logon page

Wireless

In User Name, type admin.
In Password, type the administrator password that you assigned to the web interface earlier.

Click Log On. The web interface refreshes, and then displays the vSZ dashboard page, which indicates that you have
logged on successfully.

You are now ready to configure the controller. For information on how to configure the controller, refer to the Administrator
Guide for the controller platform that you have installed.

176
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Deploy vSZ on ESXi Server

Hardware Requirement and Prerequisite for ESXi Server

The following are the hardware and prerequisite for deploying vSZ on ESXi 5.0

Hardware Requirement

1.

9.

© N o v A~ W DN

DELL Inc. PowerEdge R530

ESXi Server License 6.5

Broadcom NetXtreme BCM5720 Gigabit Ethernet 4 Ports
Intel Ethernet 10G 2P X520

CPU minimum 8 cores

vSphere ESXi Server 6.7 or later

1 or 3vNICs

16 GB memory

256 GB Hard disk

Prerequisite

A hypervisor on ESXi to install vSZ. Recommended version is ESXi 6.7 and later.
Download the vSZ package (.OVA file) from Ruckus support.

The IP addresses, netmask, gateway, DNS, DHCP and NAT support for vSZ.

Ensure that the vSZ license that you have, is a high-capacity mode or an essential mode.

Ensure the number of physical network interfaces. Choose the interface group, 3 or 1, that would be used implement for
VSZ. vSZ-E mode supports only 1 interface group. vSZ-H mode supports both 3 and 1 interface groups.

Before you power on vSZ, ensure that the networking is configured on ESXi.

Recommended to use static network addresses that are assigned to vSZ during setup.

NOTE
Due to different servers and NIC, the deployment procedure mentioned in this section is for reference.
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Topology for vSZ Deployment on ESXi 5.0 Server

The network topologies for vSZ deployment on ESXi 5.0 server.

The following are basic topologies for setting up vSZ. Based on your requirement you can choose any of the alternatives for
deployment.
* High-Scale mode with three group interfaces.

FIGURE 162 vSZ-H with Three Group Interfaces

T Control
Management Cluster ( 10.10.0.0M16
172.17.65.0124 192.168.2.0/24 “_ APs DHCF K NAT <

s W
@\ o

Cluster Control Management

J"f-ﬁ ,

Management >

Ruckus vDP

(>

Ruckus v&Z

ESXi 5.5 and later ESXi 5.5 and later

* Essentials mode with one group interface.
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FIGURE 163 Example 1: vSZ-E with one Group Interface

. e

-

14

10.10.0.0/16 _Z'
Management / Cluster / Cont L3 Router | APs DHGP NAT ¢

Y

172.17.65.0/24

J“;——"

\

[—‘@_Minagemn

Management / C-Iustar { Control

\ﬁﬁ 21 p X = =g

Data

Ruckus vSZ Ruckus vDP

O

ESXi 5.5 and later ESXi 5.5 and later

FIGURE 164 Example 2: vSZ-E with one Group Interface

s //-d_ _—1-\-“\’ _'"““H
Management / Cluster / Control / Data
10.10.0.0 16
- é iPs , DHCP , NAT &)
S 2 SEEREE
S Eome®
«—NManagemen @

Management / Cluster / Control

Data

Ruckus v52 Ruckus vDP

O

ESXi 5.5 and later ESXi §.5 and later
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Deployment Procedure on the ESXi Server

The following are basic instructions for setting up vSZ on the ESXi server.

180
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VMware ESXi 6.7 is installed and working.

1. Login to the server through vSphere client tool as seen below.

FIGURE 165 Login to vSphere

vimware

VMware vSphere”
Client

L4 AlvSphere features introduced in vSphere 5.5 and beyond are avaiable
only through the vSphere Web Clent. The traditional vSphere Clent wil
continue to operate, supporting the same feature set as vSphere 5.0,

To directhy manage a single hast, enter the IP address or host

Naime.

To manage muiltiple hosts, enter the 1P address or name of a

vCenter Server.
IP address / Name: [172.17.65.43 ]|
User name: froot
Password: I::::--:::I

I Use Windows session credentials

[ toon ]| ome

The vSphere Client management page appears as shown in the following figure.
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FIGURE 166 vSphere Client management page
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Navigate to Configuration > Network Adapters.

below.

FIGURE 167 Define network adapters

Tritianed by | Raguested Stat 1 | Gh Time

Kama Target or Stetm comten - | -

Metwork Adapiers

Device Speed | Configured | Switch | MAC Address | Observd [P ranges ‘Wake o LAN Sup...
Broadoom Corporatien NetXtrems BOM5 720 Gigabit Ethernet

i vl Custer 10040 ... 000 Full vEwichd L8666 dac e, MNone 1]

vl Down  Megotiabe Hane 1866dac?oc. Mone L

W wncl  Controd ECT PP e e a] 71| wielchl  18:660da 7. 1061000.1-10.10.2552= Na

B v Management 1000 .. 1000 Ful wheichD  18cbBadscPee. ITEITAS08-172.17. N

Imtel{R) Ethernet 106G 39 X520 Adapter

[ B = Dorem Megotiabe Maone a0:35:91-98:4_ MNone Ho

W vmncd Data 100HH)... Megotiabe vawich  a0:35:0fRed.  10000.0,0-10.10.2552- Mo

Ensure the physical ports are linked to the correct port speed as seen
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3. Create each vSphere standard switch (vSwitch) using the physical network adapters since vSZ requires three interfaces
for management, cluster, and control. Navigate to Configuration > Networking > Add Networking. Select the option
Virtual Machine to choose the connection type.

FIGURE 168 Define connection type

4 ke vemwnek wizard

CawvininThoat 1 gjse
Fictwodung hardware-can be parifonod to accommodeic oech sorvice bt regquis corredby,

[

Ak ] Pt 10 T VWL (PG Pt T

Wl

Thie issarmiel TP/ stack Fasdies. trafic or the dolloming E520 sereces wSphere valonon, SCSL WS, and host
rarageTert

4. Click Next.
5. Select the Network Adapter from the list and click Next.
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6. Enter the Network Label and click Next as shown in the following figure.

FIGURE 169 Define the Network Adapter

() At ot e _\_r'_':"‘-la
Wil s | o Thon Settiegs
Use rachear b bsben 2 ety s st o et et oo b b o e s
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|

|

| sm | et |
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Click Finish.
View the created vSwitch as seen below.

FIGURE 170 View created vSwtich

standard Switch: vSwitchd Remove.,. Properties...
Virftual Machine Po Gigap Phiyiat sl &dagbes Examgpile
O TEST ELB ¥ B8 vmnic2 =
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9. Repeat step 3 to step 6 to create three vSwitch for vSZ. View the created vSwitch as seen below.

NOTE
vSZ management interface is associated to the Control-IP-Domain.

FIGURE 171 View vSwitch for management and data interfaces

View: vsphere Standard Switch
Networking

Standand Seilch: vSwitchd Remove... Propertes,
Wirtual Machine Port Group Phvyzac al Adaplers
= Management-Intertaoes B 4t BB vmnicD 1000 Full ©
= 1 wvirtual machine(s) | VLAN 10: Al (4095)
DP-THO-vs2-5.0.0.0.356 &
VMigmel Port
o Management Nepwark &
wmkl : 172.17.65.43
ALL1NEA22 203333509040
11166 dalf-fercob?

Srandard Switch: vSwitchl Remove.,, Propertes...
Wirkual Maching Port Group Phiysical Adapters
@ Control-Interface & ¢ 4 vmnicl 1000 Fuil &
= 2 virual machine(s) | VLAN ID: Al (4095)
DP-THO-wdp-5.0.0.0,356 @
DF-THO-vsz-5.0.0.0.356 -
Standard Switch: vSwitch2 Remove.. Properties...
Virtual Machine Port Group Phiysical &dapters
+ Data-Interface & 44—l vmnicd 10000 Full &
= |1 wirtual machine(s) | VILAN ID: All (4095])
DP-THO-wdp-5.0.0.0.256 =)
Standard Switch: vSwitch3 Remowe... Fropertes..
Wirtual Hachine Padt Group Phyysical Adapilern
P Cluster-Interface - 2 B wmnic3 1000 Full 2

= 1 wirtual machine(s)

DP-THO-vs2-5.0.0.0.356 (G

10. Download the vSZ (.ova file) from the Ruckus Website.
11. Click File > Deploy OVF Template.

The Deploy OVF Template form appears.
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12. Click Browse to select the source location to install the OVF package as shown in the following figure.

FIGURE 172 Deploy the file

(B Degioy OVF Template

ey e e o F,
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13. Click Next.
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14. Enter the vSZ datastore name and choose the disk format as seen below.

FIGURE 173 Choose the disk format

[ Depioy OWF Templats

1 Dk it
'] W wirmch Posmat oy peCi WD T LW Tl il s

Datrdens: Whalasional
T swalabe woce (CBY [ eaae
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15. Click Next and wait for deploying.
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16. From the vSphere client, select Edit Settings to change network interface settings for vSZ-H and vSZ-E as shown in the

following figure.

FIGURE 174 Edit Settings

* 172.17,65.43 - vsphere Client
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Remeone from Imventory
Delete from Disk

Open in Mew Window... Ctrl+Alt+N
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17. By default, vSZ supports three network interfaces as shown in the figure.

FIGURE 175 vSZ-H Mode Running Three Interfaces

=1 Edit settings - v8Z_1 (ESXi 5.0 virtual machine)

[ Virtual Hardware ] Wi Options

3 Add hard disk MM Add network adapter =] Add other device

» [ cPU 3 O
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» o Hard disk 1 200 fe]=! v
3 SCSl Controller O LS Logic SAS r
» MW Network Adapter 1 Contral ¥ |# Connect
» MW Network Adapter 2 Wi Network ¥ |#| Connect
» EH Network Adapter 3 WM Network v |¥| Connect %
» [ Video Card Specify custom settings v
Save ‘ | Cancel
&
NOTE

If your vSZ is running as Essential mode, select two interfaces and click the £} Remove button.

Connect to vSZ Using CLI on ESXi Server

Follow the below procedures to connect to vSZ.

Open a CLI console window to run the deployed vSZ.
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FIGURE 176 Run vSZ on the console

(5 Example on ESXi-IP43.video54.local

File View WM

1. Atthe login prompt, login using administrator credentials of username and password. Run the setup command to
initialize vSZ as shown in the figure below.
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FIGURE 177 Login and Privileged mode
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2. Enter 2 for High-Scale mode and press Y to continue.

Enter static IP address for control interface as shown in the figure below.

FIGURE 178 Static IP Address for Control Interface
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4. Enter static IP address for cluster interface as shown in the figure below.

FIGURE 179 Static IP Address for Cluster Interface

L ]

5. Enter static IP address for management interface as shown in the figure below.

FIGURE 180 Static IP Address for Management Interface
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6. Select the default gateway interface. Enter 1 for control interface, 2 for cluster interface, and 3 for management
interface as shown in the figure below.

FIGURE 181 Default Gateway Interface
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Enter the DNS server setting and press Y to apply all setting.

FIGURE 182 DNS Server Settings

'n' to modifl

Access the web link http://172.17.65.234:8443 to continue other setting as shown in the figure below.

FIGURE 183 vSZ Web Ul
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9. Enter your Cluster Information and click Next as shown in the following figure.

FIGURE 184 Cluster Information
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10. Enter your vSZ Administrator password requirements and click Next as shown in the following figure.

FIGURE 185 vSZ Administrator Password
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11. Click Finish and wait until vSZ is configured.

12. After vSZ is configured, reconnect to vSZ web as shown in the following figure.

FIGURE 186 vSZ Configuration
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13. Enter Username and Password to access vSZ as shown in the following figure.

FIGURE 187 vSZ Homepage

Health - ®
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Deploy vSZ on Linux Server

Hardware Requirement and Prerequisite for LINUX CentOS 7
The following are the hardware and prerequisite for deploying vSZ on LINUX CentOS 7.

Hardware Requirement

1.
2.
3.
4,

DELL Inc. PowerEdge R320

Linux CentOS 7

Broadcom NetXtreme BCM5720 Gigabit Ethernet 2 Ports
Intel Ethernet 10G 2P X520

Prerequisite

A Linux host enabled KVM which to install vSZ VM. Prefer CentOS 7 and later.
Download the vSZ package (.qcow2 file) from Ruckus support.

The IP addresses, netmask, gateway, DNS, DHCP and NAT support for vSZ.

Ensure if the vSZ license that you have, is a high-capacity mode or an essential mode.

1Ensure the number of physical network interfaces. Choose the interface group, 3 or 1, that would be used implement
for vSZ. vSZ-E mode supports only 1 interface group. vSZ-H mode supports both 3 and 1 interface groups.

Before you power on vSZ, ensure that the networking is configured on LINUX.
Recommended to use static network addresses that are assigned to vSZ during setup.

Using CentOS 7, install KYM package with the yum command.

root@localhost ruckusvncl# yum -y install gemu-kvm gemu-img virt-manager virt-viewer virt-install
libvirt libvirt-phthon libvirt-client
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*  Ensure KVM is active and running the following command.

[root@localhost ruckusvnc]# systemctl status libvirtd

* Edit the following commands and file.
sudo yum install grub2-common

gedit /etc/default/grub

GRUB_TIMEOUT=5

GRUB_DISTRIBUTOR="S (sed 's, release .*$,,g' /etc/system-release)"

GRUBiDEFAULT=Saved

GRUB_DISABLE_ SUBMENU=true

GRUB_TERMINAL OUTPUT="console"

GRUB_CMDLINE LINUX="crashkernel=auto rd.lvm.lv=centos/root rd.lvm.lv=centos/swap rhgb quiet
intel iommu=on"

GRUB_ DISABLE RECOVERY="true"

sudo grub2-mkconfig -o /boot/grub2/grub.cfg
*  Reboot Linux host.

NOTE
Due to different servers and NIC, the deployment procedure mentioned in this section is for reference.

Topology for vSZ Deployment on LINUX CentOS7

The network topologies for vSZ deployment on LINUX CentOS 7.

The following are basic topologies for setting up vSZ. Based on your requirement you can choose any of the alternatives for
deployment.

* High-Scale mode with three group interfaces.
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FIGURE 188 vSZ-H with Three Group Interfaces

o S

~ -

ra

/" Management | Cluster {
T2.17.65.0/24 192.168.2.0/24

\ii@@ﬁ
| |
8

ra
I
5,

anagement >

Ruckus vS2

Linux host with KM

* Essentials mode with one group interface.
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FIGURE 189 Example 1: vSZ-E with one Group Interface
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FIGURE 190 Example 2: vSZ-E with one Group Interface
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Deployment Procedure on the LINUX Server
The following are basic instructions for setting up vSZ on LINUX KVM.
LINUX CentOS 7 KVM Package is installed and working.

1. Download vSZ package (.qcow?2 file) from Ruckus website.

2. From VNC Viewer, click System Tools and open the Virtual Machine Manager tool. The vSZ status must appear
Running as shown in the following figure.

FIGURE 191 Virtual Machine Manager
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3. Create a new VM.

a) Click File and select New Virtual Machine as shown in the following figure.

FIGURE 192 Creating a Virtual Machine

Virtual Machine Manager - =] x

File Edit View Help

Add Connection...

Mew Virtual Machime
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b) Inthe New VM dialog box, choose the disk format option as shown in the following figure.

FIGURE 193 Disk Format

Mew VM

m Create a new virtual machine

Connection: QEMU/KYM

Choose how you would like to install the operating system
Local install media (IS0 image or CDROM)
Network Install (HTTP, FTP. or NFS)
MNetwork Boot (PXE)

* Import existing disk image

et

Cancel Forward
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¢) Click Forward.

d) Choose destination storage path and storage volume. Click Browse Local as show in the following figure.

FIGURE 194 Storage Volume
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Choose Storage Volume X
dafault Size: 38.50 GiB Free / 11.48 GiB In Use
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e) Select the vSZ file and click Open as shown in the following figure.

FIGURE 195 vSZ File

TFTETTy ; ot Y viewe

£ Haw
B Pt

o Wdeon

| % Oehan Lecaber

f)  To select the storage path, click Browse as shown in the following figure.
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FIGURE 196 Storage Path

MNew VM x |

m Create a new virtual machine

Provide the existing storage path:
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Choose an operating system type and version
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g) Click Forward.

h) Enter the Memory (RAM) and CPUs setting as shown in the following figure.

NOTE
Memory (RAM) must be 15GB and CPUs must be 4 cores.
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FIGURE 197 Memory and CPU Settings
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m Create a new virtual machine

Choose Memory and CPU settings
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Cancel Back Forward

i)  Click Forward.

j)  To confirm the installation process, click Finish as shown in the following figure.

NOTE
The sequence for Network interfaces must first be Management and the Data.
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FIGURE 198 Installation Confirmation
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4. From the VNC Viewer, click Add Hardware, select the NIC and choose the Device model to update the Control, Cluster
and Management interface associate as shown in the following figures.

NOTE
vSZ needs three interfaces; Control, Cluster, and Management.

NOTE
For Essential mode, you need not add two NICs.

FIGURE 199 Control Interface
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FIGURE 200 Cluster Interface
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5. Define the CPU Configuration. Select the Copy host CPU configuration check box as shown in the following figure.

FIGURE 202 CPU Configuration
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6. Define the IDE Disk Configuration. Choose the Disk bus option as shown in the following figure.

FIGURE 203 IDE Disk Configuration
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7. Select Begin Installation as shown in the following figure.

FIGURE 204 Begin Installation
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Connect to vSZ Using CLI on LINUX Server

Follow the below procedures to connect to vSZ.

Open a CLI console window to run the deployed vSZ.

210
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FIGURE 205 Run vSZ on the console
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1. Atthe login prompt, login using administrator credentials of username and password. Run the setup command to
initialize vSZ as shown in the figure below.
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FIGURE 206 Login and Privileged mode
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2. Enter 2 for High-Scale mode and press Y to continue.
Choose IP version IPv4 only or IPv4 and IPv6. For example, press 1 for IPv4.

Enter static IP address for control interface as shown in the figure below.

FIGURE 207 Static IP Address for Control Interface
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5. Enter static IP address for cluster interface as shown in the figure below.

FIGURE 208 Static IP Address for Cluster Interface
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6. Enter static IP address for management interface as shown in the figure below.

FIGURE 209 Static IP Address for Management Interface
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7. Select the default gateway interface. Enter 1 for control interface, 2 for cluster interface, and 3 for management
interface as shown in the figure below.

FIGURE 210 Default Gateway Interface
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8. Enter the DNS server setting and press Y to apply all setting.

FIGURE 211 DNS Server Settings

'n' to modifl

9. Access the web link http://172.17.65.234:8443 to continue other setting as shown in the figure below.

FIGURE 212 vSZ Web Ul
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10. Enter your Cluster Information and click Next as shown in the following figure.

FIGURE 213 Cluster Information
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11. Enter your vSZ Administrator password requirements and click Next as shown in the following figure.

FIGURE 214 vSZ Administrator Password

Admindstrator

Erlii Al fuirianrdl e Pis sordd Whi] Sebrrslis adnbbilrallog dciiris Bo L Woely il erlace. U Ushi nlcrmalion 1o log inlo The Yeb Inbeilacs alter UhH o b compdeds, be Turthes oond
Larele rerh s |

FENTY Terrs Ly NS—

ol Paijmgrd o1

Db CLI enabie paiy

Enables Pidgward © o

Comfirm Pageesrd © sornnnn

12. Click Finish and wait until vSZ is configured.

13. After vSZ is configured, reconnect to vSZ web as shown in the following figure.

FIGURE 215 vSZ Configuration
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14. Enter Username and Password to access vSZ as shown in the following figure.

FIGURE 216 vSZ Homepage
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Upgrading the Controller for Microsoft Azure,
AWS, and GCE Platforms

Ruckus Networks may periodically release controller software updates that contain new features, enhancements, and fixes for
known issues.

These software updates may be made available on the Ruckus Networkssupport website or released through authorized
channels.

CAUTION

A Although the software upgrade process has been designed to preserve all controller settings, Ruckus Networks
strongly recommends that you back up the controller cluster before performing an upgrade. Having a cluster
backup will ensure that you can easily restore the controller system if the upgrade process fails for any reason.

CAUTION
Ruckus Networks strongly recommends that you ensure that all interface cables are intact during the upgrade

procedure.

CAUTION
Ruckus Networks strongly recommends that you ensure that the power supply is not disrupted during the
upgrade procedure.

NOTE
If you are managing a vSZ, you can also perform system configuration backup, restore, and upgrade from the controller
command line interface.

Upgrading the Controller Software

This section outlines the procedure to upgrade the controller software for Microsoft Azure, Amazon Web Services, Google
Computing Engine platforms.

Follow these steps to upgrade the controller software.

CAUTION
A Ruckus Networks strongly recommends backing up the controller cluster before performing the upgrade. If the
upgrade process fails for any reason, you can use the latest backup file to restore the controller cluster.
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NOTE
Before starting this procedure, you should have already obtained a valid controller software upgrade file from Ruckus
Networks Support or an authorized reseller.

VSZ supports APs starting version 3.4. You must first upgrade the vSZ. Only a new vSZ can handle an old vDP. During the vSZ
upgrade, all tunnels will stay up except the main tunnel which moves to the vSZ.

Upgrade to 5.0 does not support data migration (statistics, events, administrator logs). Existing system and network configuration
is preserved. For further clarification, Contact Ruckus support.

To Upgrade:

1. Copy the software upgrade file that you received from Ruckus Networks to the computer where you are accessing the
controller web interface or to any location on the network that is accessible from the web interface.
Go to Administration > Upgrade.

3. Inthe Upload section, click the Browse button, and then browse to the location of the software upgrade file.
Typically, the file name of the software upgrade file is scg-installer {version}.ximg.

Select the Run Pre-Upgrade Validations check box to verify if the data migration was successful. This option allows you
to verify data migration errors before performing the upgrade. If data migration was unsuccessful, the following error is
displayed: Exception occurred during the validation of data migration. Please apply the system

configuration backup and contact system administrator.

FIGURE 217 Click Browse in the Upload section to upload the software upgrade file

Upgrade | Upgrade History | DP Patch | AP Patch

Current System Information

AP Firmware Version

Upload
Run Pre-Upgrade Validations(lt will take a few minutes to check if the system has sufficient resources to complete the upgrade)

Upload the patch file (*.ximg) that you want to use to upgrade the controller.

Browse

Patch for Pending Upgrade

4. Select the software upgrade file, and then click Open.

5. Click Upload to upload the software upgrade file. The controller uploads the file to its database, and then performs file
verification. After the file is verified, the Upgrade Pending Patch Information section is populated with information
about the upgrade file.
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6. Startthe upgrade process by clicking one of the following buttons:

* Upgrade: Click this button to start the upgrade process without backing up the current controller cluster or its
system configuration.

* Backup & Upgrade: Click this button to back up the controller cluster and system configuration before performing
the upgrade.

CAUTION

A Ruckus Networks strongly recommends using Backup & Upgrade when performing the upgrade. If
the upgrade process fails for any reason, you can use the latest backup file to restore the controller
cluster.

A confirmation message appears.
7. Click Yes.

The controller starts the process that you selected. The screens that appear next will depend on the process that you
selected to upgrade immediately or to back up and then upgrade the controller.

FIGURE 218 The System Upgrade page displays the status of the upgrade process

ﬁ Ruckus Virtual SmartZone - High Scale

System is performing cluster operation, please wait...

Current Cluster Operation: BackupAndUpgrade
36% completed...

Progress Message

VWSCG34 36% completed... Taking a snapshot of the system...

When the upgrade (or backup-and-upgrade) process is complete, the controller logs you off the web interface automatically. Wait
for a few minutes until the web interface log on page appears.

FIGURE 219 The controller web interface may display the following message as it completes the upgrade process

2% SCC serveris down of the remote server is unreachable due fo network problems.
System is trying to reconnect SCG semver.Please wail..

When the controller logon page appears again, you have completed upgrading the controller.
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Continue to the Verifying the Upgrade task to check if the upgrade was completed successfully.

Verifying the Upgrade

Follow these steps to verify that the controller upgrade was completed successfully.

1.
2.

Log on to the controller web interface.
Go to Administration > Upgrade.
In the Current System Information section, check the value for Controller Version.

If the firmware version is newer than the firmware version that controller was using before you started the upgrade
process, then the upgrade process was completed successfully.

NOTE

APs periodically send scheduled configuration requests to the controller, including the firmware version.
Therefore, when an AP joins a zone for the first time, the firmware version is verified by the controller. If the
firmware version is different from that which is configured for the zone, the controller responds with a request
to upgrade it, after which the AP initiates a request to upgrade the firmware using HTTP.

FIGURE 220 Check the value for Controller Version

Upgrade | Upgrade History | DP Patch | AP Patch

Current System Information

Controll

Upload

7] Run Pre-Upgrade Validations(It will take a few minutes to check if the system has sufficient resources to complete the upgrade)

Upload the patch file (*.ximg) that you want to use to upgrade the controller.

Patch for Pending Upgrade

Rolling Back to a Previous Software Version

There are two scenarios in which you may want to roll back the controller software to a previous version:

220

1.

You encounter issues during the software upgrade process and the controller cannot be upgraded successfully. In this
scenario, you can only perform the software rollback from the CLI using the restore local command. If you have a two-
node controller cluster, run the restore local command on each of the nodes to restore them to the previous software
before attempting to upgrade them again.

You prefer a previous software version to the newer version to which you have upgraded successfully. For example, you

feel that the controller does not operate normally after you upgraded to the newer version and you want to restore the
previous software version, which was more stable. In this scenario, you can perform the software rollback either from
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the web interface or the CLI. If you have a two-node controller cluster, you must have cluster backup on both of the
nodes.

To ensure that you will be able to roll back to a previous version, Ruckus Networks strongly recommends the following before
attempting to upgrade the controller software:

*  Always back up the controller before attempting a software upgrade. If you are managing a multi-node cluster, back up
the entire cluster, and then verify that the backup process completes successfully. See Creating a Cluster Backup on
page 221 for more information.

* Ifyou have an FTP server, back up the entire cluster and upload the backup files from all the nodes in a cluster to a
remote FTP server.

Backing Up and Restoring Clusters

Back up the controller cluster periodically to ensure that you can restore the control plane, data plane, and AP firmware versions
as well as the system configuration in the cluster if is a system failure occurs.

This section covers the following topics:

NOTE

You can also perform these procedures from the vSZ command line interface. Note, however, that you will need to
execute the commands on each node.

Creating a Cluster Backup
Follow these steps to back up an entire controller cluster.
1. Take note of the current system time.

To view the current system time, go to System > General Settings > Time.
Go to Administration > Backup & Restore.
Click Backup Entire Cluster.

The following confirmation message appears: Are you sure you want to back up the cluster?
4. Click Yes.

The following message appears: The cluster is in maintenance mode. Please wait a few minutes.

When the cluster backup process is complete, a new entry appears in the Cluster Backups section with a Created On value that
is approximate to the time when you started the cluster backup process.

NOTE

If you have an FTP server, back up the entire cluster and upload the backup files from all the nodes in a cluster to a
remote FTP server.

You have completed backing up the controller cluster.

Ruckus Virtual SmartZone Getting Started Guide
Part Number: 800-71961-001 Rev A 221



Upgrading the Controller for Microsoft Azure, AWS, and GCE Platforms
Rolling Back to a Previous Software Version

FIGURE 221 A new entry appears in the Cluster Backups section

Cluster | Configuration

Cluster Backup and Restore

Back up the cluster regul

ror occurs. Ruckus Wireless also recommends backing up the cluster before upgrading the controller's software. A cluster backup includes the controller’s 05, firmware
versions (control planes as

& Back Up Entire Cluster

Cluster Backups History

£ Refresh

File Size

1.1G8

T total records T

Restoring a Cluster Backup

When restoring a cluster backup, remember that you must perform the restore procedure on the exact same node which you

generated the cluster backup.
Follow these steps to restore a cluster backup

1. Go to Administration > Backup & Restore.

2. Inthe Cluster Backups History section, locate the cluster backup that you want to restore.

3. Select the backup file that you want to restore, and then click Restore.

FIGURE 222 Select the backup file, and then click Restore

Cluster | Configuration

Cluster Backup and Restore

Back up the clu egular ror occurs. Ruckus Wireless also recommends backing up the cluster before upgrading the controller’s software. A cluster backup includes the controller’s 0S, firmware
versions (control planes and
&3 Back Up Entire Cluster
Cluster Backups History
Patch Version Created On File Size
3.5.0.0.597 2017/03/22 08:54:21 1.1GB
1 total records 1
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4. The following confirmation message appears: Are you sure you want to restore the cluster?. Click Yes.
FIGURE 223 Confirm Restore

Confirmation

?/ Are you sure you want to restore the cluster?

b= P

The page refreshes, and then the following message appears: System is restoring! Please wait...

NOTE

The cluster restore process may take several minutes to complete.

When the restore process is complete, the controller logs you off the web interface automatically.

Do not refresh the controller web interface while the restore process is in progress. Wait for the restore process
to complete successfully.

5. Log back on to the controller web interface.

NOTE

If the web interface displays the message Cluster is out of service. Please try again in a few
minutes. appears after you log on to the controller web interface, wait for about three minutes. The
dashboard will appear shortly. The message appears because the controller is still initializing its processes.

6. Go to Administration > Upgrade, and then check the Current System Information section and verify that all nodes in
the cluster have been restored to the previous version and are all in service.

7. Go to Diagnostics > Application Logs .

8. Check the Health Status column and verify that all of the controller processes are online.

You have completed restoring the cluster backup. After the upgrade is complete, go to the Application Logs page and verify that
all of the controller processes are online.
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FIGURE 224 On the Application Logs page, verify that all controller processes are online
Application Logs
Select Control Plane:

Application Logs & Status

+~ Refresh X Download All Logs | & Download Snapshot Logs
Application Name Health Status Log Level # of Logs
AP Diagnostic Information 0
CaptivePortal Online WARN 7
Cassandra Online 7
CHR Online WARN 1
Configurer Online WARN 15
Core Online WARN 19
DBlade 0
Diagnostics 0
EAut Online ‘WARN 3
ElasticSearch Online 4
Online 'WARN 1
MdProxy Online WARN 1
Memcached Online 1
MemProxy Online WARN 1
Mosquitto Online 4
MsgDist Online 'WARN 1
NC Online ‘WARN 1
NginX Online 3
Observer Online WARN 1

Restoring a Cluster Backup Using the CLI
Follow these steps to restore a cluster backup using the CLI.

1. Enter the vSZ CLI.

2. Enter the following command and enter the password to log into the CLI.

VSCG35> en
Password:

3. Enter the following command to restore a cluster backup:
VSCG35> restore

All the cluster backups are listed in an order of the cluster backup created date.

4. Specify the number mentioned against the cluster backup that you wish to restore.

You have restored the cluster backup.

224
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FIGURE 225 Cluster Backup Restore Using CLI

VSC634>
Password

VSCG34# restore
config local network

VSCG34# resto

999MB
1GB

> choose a backup to restore or 'No' to cancel: 2
Please make sure the restore backup version available in all nodes in the cluster, otherwise restore process will fail
This action will reboot the system. Do you want to restore whole cluster system (or input 'no' to cancel)? [yes/no] yusl

Follow these steps to delete a cluster backup.

1. Go to Administration > Backup & Restore.

2. Inthe Cluster Backups History section of the Cluster tab, locate the cluster backup that you want to delete, and then
click it.

The cluster backup becomes highlighted, which indicates that you have selected it.

3.
M Delete

Click

A confirmation message appears.

FIGURE 226 After you click the Delete button, a confirmation message appears

X
Are you sure you want to delete the selected
resource?

4. Click Yes.

The page refreshes, and then the cluster backup that you deleted disappears from the Cluster Backups History
section.

You have completed deleting a cluster backup.
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